Notice

The company reserves the right to revise this publication or to change its contents without notice. Information contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse) of this publication.

This publication and any accompanying software may not, in whole or in part, be reproduced, translated, transmitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators of this publication, except for copies kept by the user for backup purposes.

Brand and product names mentioned in this publication may or may not be copyrights and/or registered trademarks of their respective companies. They are mentioned for identification purposes only and are not intended as an endorsement of that product or its manufacturer.

©September 2010

Trademarks

Intel and Intel Core are trademarks/registered trademarks of Intel Corporation.
Preface

R&TTE Directive
This device is in compliance with the essential requirements and other relevant provisions of the R&TTE Directive 1999/5/EC.

This device will be sold in the following EEA countries: Austria, Italy, Belgium, Liechtenstein, Denmark, Luxembourg, Finland, Netherlands, France, Norway, Germany, Portugal, Greece, Spain, Iceland, Sweden, Ireland, United Kingdom, Cyprus, Czech Republic, Estonia, Hungary, Latvia, Lithuania, Malta, Slovakia, Poland, Slovenia.

CE Marking
This device has been tested to and conforms to the regulatory requirements of the European Union and has attained CE Marking. The CE Mark is a conformity marking consisting of the letters “CE”. The CE Mark applies to products regulated by certain European health, safety and environmental protection legislation. The CE Mark is obligatory for products it applies to: the manufacturer affixes the marking in order to be allowed to sell his product in the European market.

This product conforms to the essential requirements of the R&TTE directive 1999/5/EC in order to attain CE Marking. A notified body has determined that this device has properly demonstrated that the requirements of the directive have been met and has issued a favorable certificate of expert opinion. As such the device will bear the notified body number 0560 after the CE mark.

The CE Marking is not a quality mark. Foremost, it refers to the safety rather than to the quality of a product. Secondly, CE Marking is mandatory for the product it applies to, whereas most quality markings are voluntary.
FCC Statement
(Federal Communications Commission)
You are cautioned that changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Re orient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.
   And
2. This device must accept any interference, including interference that may cause undesired operation of the device.
Preface

FCC RF Radiation Exposure Statement:

1. This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator and your body.

Warning

Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not expressly approved by the manufacturer for compliance with the above standards could void your authority to operate the equipment.
IMPORTANT SAFETY INSTRUCTIONS

Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet basement or near a swimming pool.
2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There may be a remote risk of electrical shock from lightning.
3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may explode. Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit (Full Range AC/DC Adapter - AC Input 100 - 240V, 50 - 60Hz DC Output 20V, 15A (300W) minimum).

This Computer’s Optical Device is a Laser Class 1 Product
Preface

Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. **Don’t drop it, or expose it to shock.** If the computer falls, the case and the components could be damaged.

   ![Diagram: Do not expose the computer to any shock or vibration.]
   ![Diagram: Do not place it on an unstable surface.]
   ![Diagram: Do not place anything heavy on the computer.]

2. **Keep it dry, and don’t overheat it.** Keep the computer and power supply away from any kind of heating element. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly damaged.

   ![Diagram: Do not expose it to excessive heat or direct sunlight.]
   ![Diagram: Do not leave it in a place where foreign matter or moisture may affect the system.]
   ![Diagram: Don’t use or store the computer in a humid environment.]
   ![Diagram: Do not place the computer on any surface that will block the Vents/Fan Intakes.]
3. **Avoid interference.** Keep the computer away from high capacity transformers, electric motors, and other strong magnetic fields. These can hinder proper performance and damage your data.

4. **Follow the proper working procedures for the computer.** Shut the computer down properly and don’t forget to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

<table>
<thead>
<tr>
<th><strong>Do not turn off the power until you properly shut down all programs.</strong></th>
<th><strong>Do not turn off any peripheral devices when the computer is on.</strong></th>
<th><strong>Do not disassemble the computer by yourself.</strong></th>
<th><strong>Perform routine maintenance on your computer.</strong></th>
</tr>
</thead>
</table>

5. **Take care when using peripheral devices.**

<table>
<thead>
<tr>
<th><strong>Use only approved brands of peripherals.</strong></th>
<th><strong>Unplug the power cord before attaching peripheral devices.</strong></th>
</tr>
</thead>
</table>
Power Safety

The computer has specific power requirements:

- Only use a power adapter approved for use with this computer.
- Your AC/DC adapter may be designed for international travel but it still requires a steady, uninterrupted power supply. If you are unsure of your local power specifications, consult your service representative or local power company.
- The power adapter may have either a 2-prong or a 3-prong grounded plug. The third prong is an important safety feature; do not defeat its purpose. If you do not have access to a compatible outlet, have a qualified electrician install one.
- When you want to unplug the power cord, be sure to disconnect it by the plug head, not by its wire.
- Make sure the socket and any extension cord(s) you use can support the total current load of all the connected devices.
- Before cleaning the computer, make sure it is disconnected from any external power supplies (i.e. AC/DC adapter or car adapter).

![Do not plug in the power cord if you are wet.](image1)
![Do not use the power cord if it is broken.](image2)
![Do not place heavy objects on the power cord.](image3)
Polymer Battery Precautions

Note the following information which is specific to polymer batteries only, and where applicable, this overrides the general battery precaution information overleaf.

- Polymer batteries may experience a slight expansion or swelling, however this is part of the battery’s safety mechanism and is not a cause for concern.
- Use proper handling procedures when using polymer batteries. Do not use polymer batteries in high ambient temperature environments, and do not store unused batteries for extended periods.

See also the general battery precautionary information overleaf for further information.
Preface

General Battery Precautions

• Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
• Do not remove any batteries from the computer while it is powered on.
• Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly result in fire.
• If you do not use the battery for an extended period, then remove the battery from the computer for storage.
• Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.
• Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qualified service personnel.
• Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries may explode or leak if exposed to fire, or improperly handled or discarded.
• Keep the battery away from metal appliances.
• Affix tape to the battery contacts before disposing of the battery.
• Do not touch the battery contacts with your hands or metal objects.

Battery Disposal & Caution

The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life, under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the manufacturer. Discard used battery according to the manufacturer’s instructions.
Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the
computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the
power supply. Then refer servicing to qualified service personnel under any of the following conditions:

- When the power cord or AC/DC adapter is damaged or frayed.
- If the computer has been exposed to rain or other liquids.
- If the computer does not work normally when you follow the operating instructions.
- If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
- If there is an unusual odor, heat or smoke coming from your computer.

Removal Warning
When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and
screw(s) before turning the computer on.
Preface

Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it's latched.
4. Disconnect the AC/DC adapter and cables. Stow them in the carrying bag.
5. The AC/DC adapter uses voltages from 100 to 240 volts so you won't need a second voltage adapter. However, check with your travel agent to see if you need any socket adapters.
6. Put the notebook in its carrying bag and secure it with the bag’s straps.
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters and/or cables.
8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hardware and software. Make sure your “papers” are handy.

Power Off Before Traveling
Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a notebook which is powered on in a travel bag may cause the Vents/Fan Intakes to be blocked. To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intakes while the computer is in use.
On the Road

In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting, keep these points in mind:

**Hand-carry the notebook** - For security, don’t let it out of your sight. In some areas, computer theft is very common. Don’t check it with “normal” luggage. Baggage handlers may not be sufficiently careful. Avoid knocking the computer against hard objects.

**Beware of Electromagnetic fields** - Devices such as metal detectors & X-ray machines can damage the computer, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note: Some airports also scan luggage with these devices.

**Fly safely** - Most airlines have regulations about the use of computers and other electronic devices in flight. These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

**Get power where you can** - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies) charged.

**Keep it dry** - If you move quickly from a cold to a warm location, water vapor can condense inside the computer. Wait a few minutes before turning it on so that any moisture can evaporate.
Developing Good Work Habits

Developing good work habits is important if you need to work in front of the computer for long periods of time. Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or other joints. The following are some tips to reduce the strain:

- Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.
- Your knees should be slightly higher than your hips. Place your feet flat on the floor or on a footrest if necessary.
- Use a chair with a back and adjust it to support your lower back comfortably.
- Sit straight so that your knees, hips and elbows form approximately 90-degree angles when you are working.
- Take periodic breaks if you are using the computer for long periods of time.

Remember to:

- Alter your posture frequently.
- Stretch and exercise your body several times a day.
- Take periodic breaks when you work at the computer for long periods of time. Frequent and short breaks are better than fewer and longer breaks.
Lighting
Proper lighting and a comfortable viewing angle can reduce eye strain and shoulder and neck muscle fatigue.

• Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
• Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
• Position the display directly in front of you at a comfortable viewing distance.
• Adjust the display-viewing angle to find the best position.

LCD Screen Care
To prevent image persistence on LCD monitors (caused by the continuous display of graphics on the screen for an extended period of time) take the following precautions:

• Set the Windows Power Plans to turn the screen off after a few minutes of screen idle time.
• Use a rotating, moving or blank screen saver (this prevents an image from being displayed too long).
• Rotate desktop background images every few days.
• Turn the monitor off when the system is not in use.

Cable TV Safety
If you have included a TV Tuner in your purchase option then pay careful attention to the following:

• Make sure that your CATV system installer has connected the Coaxial cable shield to the grounding system of the building, as close to the point of cable entry as practical.
• This reminder is provided to call the CATV system installer’s attention to Article 820-93 of the NEC (Section 54, Part I of the Canadian Electrical Code).
• The TV antenna supplied with any TV Tuner module is intended for indoor use only. Please do not use your TV Tuner module outdoors.
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notice</td>
<td>I</td>
</tr>
<tr>
<td>FCC Statement</td>
<td>III</td>
</tr>
<tr>
<td>FCC RF Radiation Exposure Statement:</td>
<td>IV</td>
</tr>
<tr>
<td>Instructions for Care and Operation</td>
<td>VI</td>
</tr>
<tr>
<td>Power Safety</td>
<td>VIII</td>
</tr>
<tr>
<td>Polymer Battery Precautions</td>
<td>IX</td>
</tr>
<tr>
<td>General Battery Precautions</td>
<td>X</td>
</tr>
<tr>
<td>Cleaning</td>
<td>XI</td>
</tr>
<tr>
<td>Servicing</td>
<td>XI</td>
</tr>
<tr>
<td>Travel Considerations</td>
<td>XII</td>
</tr>
<tr>
<td><strong>Quick Start Guide</strong></td>
<td></td>
</tr>
<tr>
<td>Overview</td>
<td>1-1</td>
</tr>
<tr>
<td>Advanced Users</td>
<td>1-2</td>
</tr>
<tr>
<td>Beginners and Not-So-Advanced Users</td>
<td>1-2</td>
</tr>
<tr>
<td>Warning Boxes</td>
<td>1-2</td>
</tr>
<tr>
<td>Not Included</td>
<td>1-3</td>
</tr>
<tr>
<td>System Software</td>
<td>1-4</td>
</tr>
<tr>
<td>RAID &amp; AHCI Setup</td>
<td>1-4</td>
</tr>
<tr>
<td>System Startup</td>
<td>1-5</td>
</tr>
<tr>
<td>System Map: LCD Panel Open &amp; Top View</td>
<td>1-6</td>
</tr>
<tr>
<td>LED Indicators</td>
<td>1-7</td>
</tr>
<tr>
<td>Touch Sensor Instant Keys</td>
<td>1-8</td>
</tr>
<tr>
<td>Keyboard</td>
<td>1-9</td>
</tr>
<tr>
<td>Function Keys &amp; Visual Indicators</td>
<td>1-10</td>
</tr>
<tr>
<td>System Map: Front &amp; Rear Views</td>
<td>1-11</td>
</tr>
<tr>
<td>System Map: Right View</td>
<td>1-12</td>
</tr>
<tr>
<td>System Map: Left View</td>
<td>1-13</td>
</tr>
<tr>
<td>System Map: Bottom View</td>
<td>1-15</td>
</tr>
<tr>
<td>Windows 7 Start Menu &amp; Control Panel</td>
<td>1-16</td>
</tr>
<tr>
<td>Video Features</td>
<td>1-17</td>
</tr>
<tr>
<td>Screen Resolution</td>
<td>1-18</td>
</tr>
<tr>
<td>NVIDIA Control Panel</td>
<td>1-19</td>
</tr>
<tr>
<td>Power Options</td>
<td>1-20</td>
</tr>
<tr>
<td><strong>Storage Devices, Mouse, Audio &amp; Printer</strong></td>
<td></td>
</tr>
<tr>
<td>Overview</td>
<td>2-1</td>
</tr>
<tr>
<td>Hard Disk Drive</td>
<td>2-2</td>
</tr>
<tr>
<td>Optical Device</td>
<td>2-3</td>
</tr>
<tr>
<td>Loading Discs</td>
<td>2-3</td>
</tr>
<tr>
<td>Handling CDs or DVDs</td>
<td>2-4</td>
</tr>
<tr>
<td>DVD Regional Codes</td>
<td>2-5</td>
</tr>
<tr>
<td>9-in-1 Card Reader</td>
<td>2-6</td>
</tr>
<tr>
<td>HDMI Ports</td>
<td>2-7</td>
</tr>
<tr>
<td>HDMI Audio Configuration</td>
<td>2-8</td>
</tr>
</tbody>
</table>
Preface

Audio Setup for LCD Monitors/ TVs with HDMI Input ........................................... 2-9
Audio Features .......................................................................................... 2-11
Setup for Audio Recording ......................................................................... 2-12
Setup for 5.1 or 7.1 Surround Sound ...................................................... 2-13
Dolby Settings .......................................................................................... 2-15
TouchPad and Buttons/Mouse ................................................................. 2-16
Gestures and Device Settings ...................................................................... 2-18
Adding a Printer .......................................................................................... 2-21
USB Printer .................................................................................................. 2-21
Install Instructions: ....................................................................................... 2-21
Parallel Printer ............................................................................................. 2-21

Power Management

Overview ........................................................................................................ 3-1
The Power Sources ....................................................................................... 3-2
AC/DC Adapter ............................................................................................ 3-2
Battery ............................................................................................................ 3-2
Turning On the Computer ........................................................................... 3-3
Power Plans ................................................................................................... 3-4
Power-Saving States ................................................................................... 3-6
Sleep ................................................................................................................ 3-6
Hibernate ....................................................................................................... 3-7
Shut down ....................................................................................................... 3-7
Configuring the Power Buttons .................................................................... 3-8
Resuming Operation ..................................................................................... 3-9
Battery Information ...................................................................................... 3-10
Conserving Battery Power ........................................................................... 3-11
Battery Life .................................................................................................... 3-12
New Battery .................................................................................................... 3-12
Recharging the Battery with the AC/DC Adapter ...................................... 3-12
Proper handling of the Battery Pack ......................................................... 3-13
Battery FAQ ................................................................................................... 3-14

Drivers & Utilities

RAID & AHCI Setup ....................................................................................... 4-1
What to Install ............................................................................................... 4-1
Module Driver Installation ........................................................................... 4-1
Driver Installation ........................................................................................ 4-2
Manual Driver Installation ........................................................................... 4-4
Updating/Reinstalling Individual Drivers .................................................. 4-4
User Account Control ................................................................................... 4-5
Windows Security Message ......................................................................... 4-5
New Hardware Found ................................................................................... 4-5
Driver Installation Procedure ....................................................................... 4-6
Chipset ............................................................................................................ 4-6
Video .............................................................................................................. 4-6
LAN ................................................................................................................ 4-6
Card Reader .................................................................................................. 4-6
TouchPad ....................................................................................................... 4-7
USB 3.0 ................................................................. 4-7
Hot Key ................................................................. 4-7
Audio ................................................................. 4-7
Windows Experience Index ......................... 4-8
Optional Drivers ............................................... 4-9
Wireless LAN ...................................................... 4-9
PC Camera ......................................................... 4-9
Consumer Infrared (for TV Tuner Remote) ........ 4-10
Turbo Memory Module ....................................... 4-10
HDMI-In Driver .................................................. 4-10
Fingerprint Reader Module ............................ 4-10

**BIOS Utilities**

Overview ......................................................... 5-1
The Power-On Self Test (POST) ......................... 5-2
Failing the POST ................................................ 5-3
Fatal Errors ...................................................... 5-3
Non-Fatal Errors ............................................... 5-3
The Setup Utility ............................................... 5-4
Entering Setup .................................................. 5-4
Setup Screens .................................................. 5-5
Main Menu ....................................................... 5-6
System Time & Date (Main Menu) ....................... 5-6
System/Extended Memory: (Main Menu) .......... 5-7
BIOS Revision/VGA Card etc. (Main Menu) .......... 5-7
Advanced Menu ............................................... 5-8
Advanced Chipset Control (Advanced Menu) ........ 5-8
SATA Mode Selection (Advanced Menu) .......... 5-9
Legacy USB Support: (Advanced Menu) ......... 5-9
Boot-time Diagnostic Screen: (Advanced Menu) .... 5-9
Reset Configuration Data (Advanced Menu) .... 5-9
Power On Boot Beep (Advanced Menu) .......... 5-10
Battery Low Alarm Beep: (Advanced Menu) .... 5-10
Advanced Chipset Control Menu .................... 5-11
Bluetooth Power Setting >
Advanced Chipset Control ................................ 5-11
Intel Virtualization Technology >
Advanced Chipset Control ................................ 5-12
Hyperthreading > Advanced Chipset Control ........ 5-12
CPU C State > Advanced Chipset Control .......... 5-12
Turbo Boost > Advanced Chipset Control .......... 5-12
Security Menu ............................................... 5-13
Set Supervisor Password (Security Menu) ....... 5-13
Set User Password (Security Menu) ................. 5-14
Password on boot (Security Menu) ..................... 5-14
Boot Menu ...................................................... 5-15
Exit Menu ...................................................... 5-16

Mustang W650 Notebook
Preface

Upgrading The Computer
Overview ................................................................. 6-1
When Not to Upgrade ............................................... 6-2
Removing the Battery .................................................. 6-3
Upgrading the Hard Disk Drive(s) ................................. 6-4
Upgrading the Optical (CD/DVD) Device ....................... 6-13
Upgrading the System Memory (RAM) ......................... 6-14

Modules
Overview ................................................................. 7-1
Setting Up SATA RAID Mode ....................................... 7-2
AHCI Mode .............................................................. 7-2
RAID ....................................................................... 7-2
Intel® Matrix Storage Manager ...................................... 7-2
SATA RAID Setup Procedure (BIOS) ........................... 7-4
RAID Setup (Intel Matrix) ........................................... 7-5
Intel Turbo Memory & Matrix Storage Setup and Driver Installation ......................................................... 7-8
Intel® Matrix Storage Manager ...................................... 7-9
RAID Volume Data Verification and Repair ..................... 7-10
Replacing and Reverting Recovery and Master Volumes ................................................................. 7-10
Bluetooth Module ...................................................... 7-12
Bluetooth Configuration in Windows 7 ......................... 7-13
Wireless LAN Module ............................................... 7-17
Intel® Wi-Fi Link Series Driver Installation ..................... 7-18
802.11b/g/n Driver Installation .................................... 7-18
Connecting to a Wireless Network in Windows 7 .......... 7-19
Intel® My WiFi Configuration ....................................... 7-22
Windows Mobility Center ........................................... 7-34
PC Camera Module ................................................... 7-35
PC Camera Driver Installation ..................................... 7-36
PC Camera Audio Setup ............................................. 7-37
TV Tuner Module ....................................................... 7-43
Consumer Infrared Driver .......................................... 7-44
Digital TV Broadcast Signal ........................................ 7-45
TV Recording and Power Plans .................................... 7-45
Remote Control Unit .................................................. 7-45
Intel Turbo Memory Module ....................................... 7-46
Intel Turbo & Matrix Storage Setup and Driver Installation ................................................................. 7-46
HDMI-In Module ....................................................... 7-51
HDMI-In Driver ......................................................... 7-51
GameMate Media Player (HDMI-In) ............................ 7-52
Fingerprint Reader Module ......................................... 7-55
Fingerprint Reader Driver Installation ......................... 7-56
User Enrollment ......................................................... 7-57
Fingerprint Control Center Features ............................ 7-60

XX

Mustang W650 Notebook
Troubleshooting
Overview ........................................................................8-1
Basic Hints and Tips ......................................................8-2
Backup and General Maintenance .................................8-3
Viruses ...........................................................................8-4
Upgrading and Adding New Hardware/Software ..........8-5
Problems & Possible Solutions ......................................8-7
Bluetooth Connection Problems ..................................8-15

Interface (Ports & Jacks)
Overview ....................................................................... A-1
Ports and Jacks .............................................................. A-2
Card Reader ................................................................. A-2
Cable (CATV) .............................................................. A-2
Antenna Jack ................................................................. A-2
Consumer Infrared Transceiver .................................. A-2
DC-In Jack ................................................................ A-2
DVI-Out Port .............................................................. A-2
e-SATA Port .............................................................. A-3
HDMI-IN Port ............................................................ A-3
Factory Option ............................................................ A-3
HDMI-Out Port ........................................................... A-3
Headphone-Out Jack .................................................. A-3
Line-In Jack ................................................................ A-3
Microphone-In Jack .................................................... A-4
Mini-IEEE 1394b Port .................................................. A-4
RJ-45 LAN Jack .......................................................... A-4
S/PDIF-Out Jack .......................................................... A-4
Security Lock Slot ........................................................ A-4
USB 2.0/1.1 Ports ........................................................ A-5
USB 3.0 Port ................................................................. A-5

NVIDIA Video Driver Controls
NVIDIA Video Driver Installation ...............................B-1
NVIDIA Control Panel (Win 7) ....................................B-2
Display Devices ............................................................B-5
Display Modes .............................................................B-6
Attaching Other Displays (Win 7) ..............................B-11
SLI Multi GPU Configuration ....................................B-14
SLI Multi GPU Configuration & Battery Power ........ B-15
Enabling TV Display ..................................................B-16

Specifications
Processor ....................................................................... C-2
Core Logic .................................................................... C-2
Display .................................................................C-2
Memory ....................................................................... C-2
Video Adapter Options ...............................................C-2
Video Adapter Options ...............................................C-2
BIOS .............................................................................C-2
Preface

Storage ................................................................. C-2
Turbo Memory ......................................................... C-2
Audio ................................................................. C-3
Keyboard & Pointing Device ..................................... C-3
Interface ............................................................... C-3
Slots ................................................................. C-3
Card Reader ............................................................ C-3
Communication ..................................................... C-4
Security ............................................................... C-4
Operating System .................................................. C-4
Power Management ................................................ C-4
Power ................................................................. C-4
Environmental Spec ................................................ C-4
Physical Dimensions & Weight ............................... C-4
Chapter 1: Quick Start Guide

Overview

This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the computer and to getting your system started. The remainder of the manual covers the following:

• Chapter 2  A guide to using some of the main features of the computer e.g. the storage devices (hard disk, optical device, card reader), TouchPad & Mouse, Audio Features & Printer.
• Chapter 3  The computer’s power management options.
• Chapter 4  The installation of the drivers and utilities essential to the operation or improvement of some of the computer’s subsystems.
• Chapter 5  An outline of the computer’s built-in software or BIOS (Basic Input Output System).
• Chapter 6  Instructions for upgrading your computer.
• Chapter 7  A quick guide to the computer’s RAID, Bluetooth, Wireless LAN, PC Camera, TV Tuner, Turbo Memory, HDMI-In and Fingerprint modules (some of which may be optional depending on your purchase configuration).
• Chapter 8  A troubleshooting guide.
• Appendix A  Definitions of the interface, ports/jacks which allow your computer to communicate with external devices.
• Appendix B  Information on the NVIDIA Video driver controls.
• Appendix C  The computer’s specification.
Quick Start Guide

Advanced Users
If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful to refer to “Drivers & Utilities” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer” on page 6 - 1 in the User’s Manual. You may also find the notes marked with a of interest to you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them) then the information contained in this Quick Start Guide should be enough to get you up and running. Eventually you should try to look through all the documentation (more detailed descriptions of the functions, setup and system controls are covered in the remainder of the User’s Manual), but do not worry if you do not understand everything the first time. Keep this manual nearby and refer to it to learn as you go. You may find it useful to refer to the notes marked with a as indicated in the margin. For a more detailed description of any of the interface ports and jacks see “Interface (Ports & Jacks)” on page A - 1.

Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the symbol. Also please note the safety and handling instructions as indicated in the Preface.
Quick Start Guide

Not Included
Operating Systems (e.g. Windows 7) and applications (e.g. word processing, spreadsheet and database programs) have their own manuals, so please consult the appropriate manuals.

Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install the appropriate drivers. Drivers are programs which act as an interface between the computer and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order listed in Table 4 - 1, on page 4 - 3. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If your system hasn’t been properly configured (your service representative may have already done that for you), refer to “Drivers & Utilities” on page 4 - 1 for installation instructions.

Ports and Jacks

See “Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your computer to communicate with external devices, connect to the internet etc.
Quick Start Guide

System Software
Your computer may already come with system software pre-installed. Where this is not the case, or where you are re-configuring your computer for a different system, you will find the Windows 7 operating system is supported.

Note: In order to run Windows 7 without limitations or decreased performance, your computer requires a minimum 1GB of system memory (RAM).

RAID & AHCI Setup
Note that setting up a RAID, or AHCI mode, needs to be done prior to installing the Windows OS (see “Setting Up SATA RAID Mode” on page 7 - 2).
System Startup

1. Remove all packing materials, and place the computer on a stable surface.
2. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
3. Attach the AC/DC adapter to the DC-In jack at the rear of the computer, then plug the AC power cord into an outlet, and connect the AC power cord to the AC/DC adapter.
4. Use one hand to raise the lid/LCD to a comfortable viewing angle (it is preferable not to exceed 135 degrees); use the other hand (as illustrated in Figure 1 - 1 below) to support the base of the computer (Note: Never lift the computer by the lid/LCD).
5. Raise the lid/LCD to a comfortable viewing angle, and press the power button.

**Figure 1 - 1 - Computer with AC/DC Adapter Plugged-In/Opening the Lid/LCD**

Shutdown

Note that you should always shut your computer down by choosing the Shut Down command from the Start menu in Windows 7. This will help prevent hard disk or system problems.
Quick Start Guide

System Map: LCD Panel Open & Top View

Figure 1 - 2
LCD Panel Open & Top View

1. Built-In PC Camera
2. Built-In Microphone
3. LCD
4. LED Status Indicators
5. Touch Sensor Instant Keys
6. Speakers
7. Power Button
8. Keyboard
9. TouchPad and Buttons
10. Fingerprint Reader Module
11. LCD Panel Color LED

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices (e.g. WLAN or Bluetooth) aboard aircraft is usually prohibited. Make sure any wireless modules are OFF if you are using the computer aboard aircraft.

Use the appropriate function key combination to toggle power to any wireless modules, and check the indicators to see if any modules are powered on or not (see Table 1 - 3, on page 1 - 8).
LED Indicators
The LED indicators display helpful information about the current status of the computer.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Blue</td>
<td>Scroll Lock is Activated</td>
</tr>
<tr>
<td></td>
<td>Blue</td>
<td>Caps Lock is Activated</td>
</tr>
<tr>
<td></td>
<td>Blue</td>
<td>Number Lock is Activated</td>
</tr>
<tr>
<td></td>
<td>Blinking Blue</td>
<td>Hard Disk Activity</td>
</tr>
</tbody>
</table>

Table 1 - 1 - LED Status Indicators

<table>
<thead>
<tr>
<th>Icon</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Orange</td>
<td>DC Power is Plugged In</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>The Computer is On</td>
</tr>
<tr>
<td></td>
<td>Blinking Green</td>
<td>The Computer is In Sleep Mode</td>
</tr>
<tr>
<td></td>
<td>Orange</td>
<td>The Battery is Charging</td>
</tr>
<tr>
<td></td>
<td>Blinking Orange</td>
<td>The Battery has Reached Critically Low Power Status</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>The Battery is Fully Charged</td>
</tr>
</tbody>
</table>

Table 1 - 2 - LED Power Indicators
Quick Start Guide

Touch Sensor Instant Keys

Press the Touch Sensor Instant Keys on the computer to toggle the appropriate function on/off. When a module is powered on the appropriate icon will be highlighted blue.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="volume.png" alt="Mute Toggle" /></td>
<td>Mute Toggle</td>
</tr>
<tr>
<td><img src="bluetooth.png" alt="Bluetooth Module" /></td>
<td>Bluetooth Module (optional) Power Toggle</td>
</tr>
<tr>
<td><img src="wireless.png" alt="Wireless LAN Module" /></td>
<td>Wireless LAN Module (optional) Power Toggle</td>
</tr>
<tr>
<td><img src="camera.png" alt="PC Camera Module" /></td>
<td>PC Camera Module Power Toggle</td>
</tr>
</tbody>
</table>

Make sure that Wireless is **ON** in the Windows Mobility Center to ensure proper wireless instant key behavior (see page 3 - 11).

- **V-**/ **V+** Volume Control (Press and hold your finger at either end **V-**/ **V+** of the volume control to adjust the system volume)

*Table 1 - 3 - Touch Sensor Instant Keys*

Note that you can also use the function key combinations for all of the functions above (see page 1 - 10).
Keyboard

The keyboard has an embedded numerical keypad for easy numeric data input, and features function keys to allow you to change operational features instantly. See Table 1 - 4, on page 1 - 10 for full function key combination details.

Figure 1 - 3 - Keyboard

Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters. These special characters can only be produced by using the numeric keypad. Regular number keys (in the upper row of the keyboard) will not work. Make sure that NumLk is on.

Mustang W650 Notebook
Quick Start Guide

Function Keys & Visual Indicators

The **function keys** (F1 - F12 etc.) will act as **hot keys** when pressed while the **Fn** key is held down. In addition to the basic function key combinations; visual indicators (see the table below) are available when the Hot Key driver is installed (see “Hot Key” on page 4 - 7). After installing the driver an icon 📱 will appear in the taskbar.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function/Visual Indicators</th>
<th>Keys</th>
<th>Function/Visual Indicators</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fn + ~</td>
<td>Play/Pause (in Audio/Video Programs)</td>
<td>Fn + F8/F9</td>
<td>Brightness Decrease/Increase</td>
</tr>
<tr>
<td>Fn + F1</td>
<td>Touchpad Toggle</td>
<td>Fn + F10</td>
<td>PC Camera Power Toggle</td>
</tr>
<tr>
<td>Fn + F2</td>
<td>Turn LCD Backlight Off (Press a key to or use Touchpad to turn on)</td>
<td>Fn + F11</td>
<td>*WLAN Module Power Toggle</td>
</tr>
<tr>
<td>Fn + F3</td>
<td>Mute Toggle</td>
<td>Fn + F12</td>
<td>Bluetooth Module Power Toggle</td>
</tr>
<tr>
<td>Fn + F4</td>
<td>Sleep Toggle</td>
<td>Fn + NumLk</td>
<td>Number Lock Toggle</td>
</tr>
<tr>
<td>Fn + F5/F6</td>
<td>Volume Decrease/Increase</td>
<td>Fn + ScrLk</td>
<td>Scroll Lock Toggle</td>
</tr>
<tr>
<td>Fn + F7</td>
<td>Display Toggle - DO NOT use when SLI is enabled</td>
<td>Fn + 5</td>
<td>Audio Toggle - Toggle between Stereo and 5.1 Surround Sound Modes</td>
</tr>
</tbody>
</table>

*Make sure that Wireless is **ON** in the **Windows Mobility Center** to ensure proper wireless function key behavior (see page 3 - 12).

Table 1 - 4 - Function Keys & Visual Indicators

**1 - 10 Keyboard**
Mustang W650 Notebook
System Map: Front & Rear Views

Figure 1 - 4
Front View

1. Consumer Infrared Transceiver (enabled with optional TV Tuner only)
2. LED Power Indicators
3. DC-In Jack
4. Vent/Fan Intake

TV Tuner Module Support
Note that the TV Tuner module (factory) option is supported by the Windows Media Center software. Windows Media Center is not included in Starter or Home Basic versions of Windows 7.
System Map: Right View

1. Line-In Jack
2. S/PDIF-Out Jack
3. Microphone-In Jack
4. Headphone-In Jack
5. 3 * USB 2.0 Ports
6. Security Lock Slot

USB Ports
Note that the connections to the USB ports only fit one way, do not force them.

USB 2.0 or 3.0 Ports
USB 3.0 ports are denoted by their blue color; USB 2.0 ports are colored black.
System Map: Left View

1. Speaker
2. DVI-Out Port
3. Cable (CATV) Antenna Jack*
4. RJ-45 LAN Jack
5. HDMI-Out Port
6. 2 * USB 3.0 Ports
7. eSATA Port
8. Mini-IEEE 1394b Port
9. HDMI-In Port (Factory Option)
10. 9-in-1 Card Reader
11. Optical Device Drive Bay

*Enabled with Optional Mini-PCI TV Tuner Only

USB 3.0 Ports
USB 3.0 ports are denoted by their blue color; USB 2.0 ports are colored black. Note that the USB 3.0 port requires a driver installation (see “USB 3.0” on page 4 - 7), does not support wake on USB and is not operational under DOS.

9-in-1 Card Reader
The card reader allows you to use the most popular digital storage card formats:
- MMC (MultiMedia Card) / RSMMC
- SD (Secure Digital) / Mini SD / SDHC / SDXC Compatible
- MS (Memory Stick) / MS Pro / MS Duo

HDMI Ports
Note that the HDMI Ports support video and audio signals to attached external displays (also see “HDMI Ports” on page 2 - 7). The HDMI-In port is enabled with the optional (Factory Option) HDMI-In Module only.

Mini-IEEE 1394b Port
The Mini-IEEE 1394b port only supports SELF POWERED IEEE 1394 devices.
Disk Eject Warning

Don’t try to eject a CD/DVD while the system is accessing it. This may cause the system to “crash”. Stop the disk first then eject it, or press the stop button twice.

CD/DVD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to an unexpected power interruption) you may push the end of a straightened paper clip into the emergency eject hole. Do not use a sharpened pencil or any object that may break and become lodged in the hole. Don’t try to remove a floppy disk/CD/DVD while the system is accessing it. This may cause the system to “crash”.

Changing DVD Regional Codes

Go to the Control Panel and double-click Device Manager (Hardware and Sound), then click the + next to DVD/CD-ROM drives. Double-click on the DVD-ROM device to bring up the Properties dialog box, and select the DVD Region (tab) to bring up the control panel to allow you to adjust the regional code.

DVD region detection is device dependent, not OS-dependent. You can select your module’s region code 5 times. The fifth selection is permanent. This cannot be altered even if you change your operating system or you use the module in another computer.
System Map: Bottom View

1. Sub Woofer
2. Fan Outlet/Intake
3. Component Bay Cover
4. Battery (Secondary HDD Bay - HDD3)
5. Primary HDD Bay (HDD1 & 2)

Overheating
To prevent your computer from overheating make sure nothing blocks the vent(s)/fan intake(s) while the computer is in use.

Battery Information
Always completely discharge, then fully charge, a new battery before using it. Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges. See “Battery Information” on page 3 - 10 for full instructions.
Windows 7 Start Menu & Control Panel

Most of the control panels, utilities and programs within Windows 7 (and most other Windows versions) are accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk drive, and a shortcut will usually be placed in the Start menu and/or the desktop. Right-click the Start menu icon, and then select Properties if you want to customize the appearance of the Start menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features in Windows (e.g. power, video, network, audio etc.). Windows 7 provides basic controls for many of the features, however many new controls are added (or existing ones are enhanced) when you install the drivers. To see all controls it may be necessary to toggle off Category View to view the control panel icons.
Video Features

You can switch display devices, and configure display options, from the **Display** control panel (in **Appearances and Personalization**) in *Windows 7*.

To access **Display (Control Panel) and Screen Resolution** in *Windows*:
1. Click **Start** and click **Control Panel**.
2. Click **Display** (icon) - In the **Appearances and Personalization** category.
3. Click **Adjust Screen Resolution/Adjust resolution**.

**OR**
4. Alternatively you can right-click the desktop and select **Screen resolution** (Figure 1 - 9 on page 1 - 18).
5. Use the dropbox to select the screen **Resolution** (Figure 1 - 9 on page 1 - 18).
6. Click **Advanced settings** (Figure 1 - 9 on page 1 - 18) to bring up the **Advanced** properties tabs.

**NVIDIA Video Controls**

More detailed video controls are provided by the **NVIDIA Control Panel**. For more detailed information see **Appendix B**.

You can also access the control panels by right-clicking the desktop and selecting **NVIDIA Control Panel/Catalyst (TM) Control Center** (Figure 1 - 9 on page 1 - 18).
Quick Start Guide

Screen Resolution

Video Options
Note that card types, specifications and drivers are subject to continual updates and changes. Check with your service center for the latest details on video cards supported.

Figure 1 - 9 - Screen Resolution
NVIDIA Control Panel
You can access the NVIDIA Control Panel as follows:

1. Click Start, and click Control Panel.
2. Click NVIDIA Control Panel ① (Figure 1 - 10) - In the Appearances and Personalization category.
3. See “NVIDIA Video Driver Controls” on page B - 1 for full details on control panels etc.
   OR
4. Click Advanced settings ③ (Figure 1 - 9 on page 1 - 18) in the Screen Resolution control panel in Windows.
5. Click GeForce....(tab) and click Start the NVIDIA Control Panel ②.

Figure 1 - 10 - NVIDIA Control Panel
Quick Start Guide

Power Options

The Power Options (Hardware and Sound menu) control panel icon in Windows (see page 1 - 16) allows you to configure power management features for your computer. You can conserve power by means of power plans and configure the options for the power button, sleep button, computer lid (when closed), display and sleep mode from the left menu. Note that the Power saver plan may have an affect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to create a new plan. Click Change plan settings and click Change advanced power settings to access further configuration options.

Pay attention to the instructions on battery care in “Battery Information” on page 3 - 10.

Figure 1 - 11 - Power Options
Chapter 2: Storage Devices, Mouse, Audio & Printer

Overview

Read this chapter to learn more about the following main features and components of the computer:

- Hard Disk Drive
- Optical Device
- 9-in-1 Card Reader
- HDMI Ports
- Audio Features
- TouchPad and Buttons/Mouse
- Adding a Printer
Storage Devices, Mouse, Audio & Printer

Hard Disk Drive

The hard disk drive(s) issuer) used to store your data in the computer. The hard disks) can be taken out to accommodate other 2.5” serial (SATA) hard disk drives with a height of 9.5 mm. The primary hard disk bay 1 is accessible from the bottom of your computer as seen below, and the secondary hard disk bay 2 is located under the battery compartment.

The computer can accommodate up to three hard disks (two in the primary bay, and one in the secondary bay), and these may be configured in RAID or AHCI modes. Further details on removing and inserting the hard disk are available in “Upgrading the Hard Disk Drive(s)” on page 6 - 4.

Figure 2 - 1
Hard Disk Location
Optical Device

There is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). The actual device will depend on the model you purchased (see “Storage” on page C - 2). The optical device is usually labeled “Drive D:” and may be used as a boot device if properly set in the BIOS (see “Boot Menu” on page 5 - 15).

Loading Discs

To insert a CD/DVD, press the open button 1 and carefully place a CD/DVD onto the disc tray with label-side facing up (use just enough force for the disc to click onto the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks” and you are ready to start. The busy indicator 2 will light up while data is being accessed, or while an audio/video CD, or DVD, is playing. If power is unexpectedly interrupted, insert an object such as a straightened paper clip into the emergency eject hole 3 to open the tray.

Sound Volume Adjustment

How high the sound volume can be set depends on the setting of the volume control within Windows. Click the Volume icon on the taskbar to check the setting.

Peripherals must be connected before you turn on the system.

Figure 2 - 2
Optical Device
Handling CDs or DVDs

Proper handling of your CDs/DVDs will prevent them from being damaged. Please follow the advice below to make sure that the data stored on your CDs/DVDs can be accessed.

Note the following:

- Hold the CD or DVD by the edges; do not touch the surface of the disc.
- Use a clean, soft, dry cloth to remove dust or fingerprints.
- Do not write on the surface with a pen.
- Do not store or place the CD or DVD in high-temperature areas.
- Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
- Do not bend the CD or DVD.
- Do not drop or subject the CD or DVD to shock.

CD Emergency Eject

If you need to manually eject a CD (e.g. due to an unexpected power interruption) you may push the end of a straightened paper clip into the emergency eject hole. However please do NOT use a sharpened pencil or similar object that may break and become lodged in the hole.

Disk Eject Warning

Don't try to remove a CD/DVD while the system is accessing it. This may cause the system to "crash".
## DVD Regional Codes

To change the DVD regional codes see "Changing DVD Regional Codes" on page 1 - 14.

<table>
<thead>
<tr>
<th>Region</th>
<th>Geographical Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>USA, Canada</td>
</tr>
<tr>
<td>2</td>
<td>Western Europe, Japan, South Africa, Middle East &amp; Egypt</td>
</tr>
<tr>
<td>3</td>
<td>South-East Asia, Taiwan, South Korea, The Philippines, Indonesia, Hong Kong</td>
</tr>
<tr>
<td>4</td>
<td>South &amp; Central America, Mexico, Australia, New Zealand</td>
</tr>
<tr>
<td>5</td>
<td>N Korea, Russia, Eastern Europe, India &amp; Most of Africa</td>
</tr>
<tr>
<td>6</td>
<td>China</td>
</tr>
</tbody>
</table>

**Table 2 - 1**

DVD Regional Coding
9-in-1 Card Reader

The card reader allows you to use some of the latest digital storage cards. Push the card into the slot and it will appear as a removable device, and can be accessed in the same way as your hard disk(s). Make sure you install the Card Reader driver (see “Card Reader” on page 4 - 6).

- MMC (MultiMedia Card) / RSMMC
- SD (Secure Digital) / Mini SD / SDHC / SDXC Compatible
- MS (Memory Stick) / MS Pro / MS Duo

Note: Some of these cards require PC adapters that are usually supplied with the cards.

Card Reader Cover

Make sure you keep the cover in the card reader when not in use. This will help prevent foreign objects and/or dust getting in to the card reader.

Figure 2 - 3
Right View

1. Card Reader
HDMI Ports

This computer has an HDMI (High-Definition Multimedia Interface) output port, and also features an **optional HDMI input port (the HDMI-In module is a Factory Option)**. HDMI is a compact audio/video interface for transmitting uncompressed digital data.

- The HDMI-Out port allows you to display and hear video/audio sources from your computer to digital TVs, displays or audio systems that support an HDMI input.
- The **optional** HDMI-In module allows you to display external sources such as Blue-ray players, DVDs, set top boxes and games consoles etc. on your computer screen.

See “**NVIDIA Video Driver Controls** from page B - 1” for information on setting up external displays connected to the HDMI-Out port.

Make sure you install the HDMI-In driver in order to support any HDMI input sources if you have included the optional HDMI-In module in your purchase configuration. When the HDMI-In driver is installed the **Game Mate Media Player** will be installed (see “**HDMI-In Module**” on page 7 - 51 for more information on the application etc.).
HDMI Audio Configuration
As HDMI (High-Definition Multimedia Interface) carries both audio and video signals you can configure the audio output as per the instructions below.

Audio Setup for HDMI
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Sound (Hardware and Sound).
3. Click Playback (tab), and click to select Realtek Digital Output.
4. Click Set Default (button).
5. Click OK to close the Sound control panel.
6. Select Speakers as the default for standard audio sources.

Figure 2-4
Sound Playback Options
Audio Setup for LCD Monitors/TVs with HDMI Input

Some LCD monitors/TVs support HDMI input, but DO NOT have built-in digital audio decoders. Where this is the case, when playing DVDs in Windows Media Player/CyberLink Power DVD, a background noise can occur. If this situation does arise then please follow the instructions below.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Sound (Hardware and Sound).
4. Click Supported Formats (tab).
5. Click to disable (remove the check in the box) DTS Audio and Dolby Digital.
6. Click OK and close the control panels.

Figure 2 - 5
Sound Supported Formats
Storage Devices, Mouse, Audio & Printer

HDMI Notes
- Connect a device with HDMI support to the HDMI-Out port **BEFORE** attempting to play audio/video sources through the device.
- If you disconnect the HDMI cable the default audio playback device will not revert to speakers until the computer is restarted (if you do not wish to restart the computer then go to the **Sound** control panel and select **Speakers** as the default audio playback device).

HDMI Video Configuration
1. Connect an HDMI cable from the HDMI-Out port to your external display.
2. Configure your external display as per the instructions in “**Configuring an External Display using the NVIDIA Control Panel**” on page B - 7.
3. Set up your external display (TV or LCD) for HDMI input (see your display device manual).
4. You can now play video/audio sources through your external display.

Other Applications
If you are using a third party application to play DVDs etc. you will need to consult the application’s documentation to see the appropriate audio configuration (the application must support digital to analog translation).
Audio Features

You can configure the audio options on your computer from the Sound control panel in Windows, or from the Realtek HD Audio Manager icon in the taskbar/control panel (right-click the taskbar icon to bring up an audio menu). The volume may also be adjusted by means of the Fn + F5/F6 key combination or by pressing your finger on either end of the Touch Sensor volume control (see Table 1 - 3, on page 1 - 8).

![Sound Manager](image)

Right-click the icon to access the menu above.

See “HDMI Audio Configuration” on page 2 - 8 for a description of the audio configuration when connecting an HDMI supported display device.
Setup for Audio Recording

To record audio sources on your computer at optimum quality follow the instructions below:

1. Click **Start**, and click **Control Panel** (or point to **Settings** and click **Control Panel**) and make sure you are in **Classic View**.
2. Click **Realtek HD Audio Manager** (or right-click the taskbar icon and select **Sound Manager**).
3. Click **Microphone Effects** (tab) in **Microphone** (tab), and then click to select **Noise Suppression** (button), or adjust the **Recording Volume** level to around 60, to obtain the optimum recording quality.
4. Click **OK** to close the control panel and save the settings.

*Figure 2 - 7*
Realtek Audio Manager - Recording Setup
Setup for 5.1 or 7.1 Surround Sound

To setup your system for 5.1 or 7.1 surround sound you will need to connect the audio cables to the Headphone-Out, Line-In, Microphone-In jack and S/PDIF-Out jacks (note: the S/PDIF jack is used for 7.1 surround sound only).

1. Click **Start**, and click **Control Panel** (or point to **Settings** and click **Control Panel**) and make sure you are in **Classic View**.
2. Click **Realtek HD Audio Manager** (or right-click the taskbar icon and select **Sound Manager**).
3. Click **Speakers** (tab) and click **Speaker Configuration** (tab).
4. Select **5.1 or 7.1 Speaker** from the **Speaker Configuration** pull-down menu.

---

**Fn + 5 Audio Toggle**

The **Fn + 5** key combination allows you to toggle the audio system between stereo and surround modes. The stereo mode will allow for a louder audio volume.

Note that if you have stereo mode enabled, and attempt to demo the speaker configuration, then the sound will only be enabled through the front and rear speakers.

---

**Auto Popup Dialog**

You should enable the auto popup dialog to automatically detect when a device has been plugged-in. If disabled, double-click **connector settings** and click the box to enable the auto popup detection of plugged-n devices.

---

**Figure 2 - 8**

Speaker Configuration (7.1)
5. Plug the front speaker cables into the Headphone-Out Jack.
6. Plug in the other cables (you may require an adapter to connect each cable to the appropriate jack e.g a stereo mini to dual RCA adapter) from your speakers as follows:
   - Line-In Jack = Rear Speaker Out
   - Microphone-In Jack = Center/Subwoofer Speaker Out
   - S/PDIF-Out Jack = Side Speaker Out (for 7.1 Surround Sound Only)
7. As you plug in each cable a dialog box will pop up (see “Auto Popup Dialog” on page 2 - 13).
8. Click to put a tick in the appropriate box according to the speaker plugged-in (e.g. Rear Speaker Out), and then click OK to save the setting.
9. Click OK to exit Realtek HD Audio Manager.

**Figure 2 - 9
Connected Device Auto Popup**

Note: Side Speaker Out is required for 7.1 Surround only.
Dolby Settings
You can adjust the Dolby settings from the Dolby tab in Speakers Properties.

1. Click **Start**, and click **Control Panel** (or point to **Settings** and click **Control Panel**).
2. Click **Sound** ( Hardware and Sound ).
3. Click **Playback** (tab).
4. Double-click **Speakers** (or select **Properties** from the right-click menu).
5. Click **Dolby** (tab)
6. Adjust the settings to your preferences and click OK.
**TouchPad and Buttons/Mouse**

The TouchPad is an alternative to the mouse; however, you can also add a mouse to your computer through one of the USB ports. The TouchPad buttons function in much the same way as a two-button mouse.

**Mouse Driver**

If you are using an external mouse your operating system may be able to auto-configure your mouse during its installation or only enable its basic functions. Be sure to check the device’s user documentation for details.
Once you have installed the TouchPad driver (see “TouchPad” on page 4 - 7) you can configure the functions from the Mouse control panel in Windows, or by double-clicking the TouchPad driver icon on the taskbar. You may then configure the TouchPad tapping, buttons, scrolling, pointer motion and sensitivity options to your preferences. You will find further information at www.synaptics.com.

**TouchPad Scrolling**

This computer model series may feature different TouchPad versions.

These TouchPads may differ in their vertical scrolling function in most scrollable windows.

Some TouchPads require sliding the finger up and down on the right of the TouchPad to scroll the window. Other versions require tapping/holding down the finger at the top right or bottom right of the TouchPad to scroll the window.
The Synaptics Gestures Suite application allows you to use a specific gesture (action) on the surface of the TouchPad to perform specific actions to manipulate documents, objects and applications.

You can configure the settings from the Device Settings tab in **Mouse Properties**:

1. Click **Start**, and click **Control Panel** (or point to **Settings** and click **Control Panel**).
2. Click **Mouse** (**Hardware and Sound)**.
3. Click **Device Settings** (tab) and click **Settings**.
4. Use the menu tree on the left to access the user configurable settings.

**Figure 2 - 12**
Mouse Properties - Device Settings

---

**Show Video**

You can get a clearer view of the gestures involved by clicking the **Show Video** option for each gesture item.

Select the gesture (Pinch Zoom, Rotating, Three Fingers Down and Three Finger Flick) in the Device Settings > Settings left tree menu and click the Show Video button to see the demonstration video.

For more details on any of the gestures see the help in the lower part of the right menu window.
Storage Devices, Mouse, Audio & Printer

Scrolling
The Two-Finger scrolling feature works in most scrollable windows and allows you to scroll horizontally and vertically. Place two fingers, slightly separated, on the TouchPad surface and slide both fingers in the direction required (in a straight continuous motion).

Figure 2 - 13
Scrolling Gesture

Zooming
The Pinch Zoom gesture can be used to perform the same function as a scroll wheel in Windows applications that support CTRL + scroll wheel zoom functionality. Place two fingers on the TouchPad (for best results use the tips of the fingers) and slide them apart to zoom in, or closer together to zoom out.

Figure 2 - 14
Zooming Gesture
Storage Devices, Mouse, Audio & Printer

**Rotating**
Use the Pivot Rotate gesture to rotate objects (e.g. photos) in 90 degree increments. Place a finger down on the left “target” zone and keep it stationary. Place another finger near the middle of the TouchPad and slide it in a circular motion around the stationary finger (clockwise or counterclockwise) to rotate the object.

*Figure 2 - 15*
Rotating Gesture

**Three Finger-Flick/Three Fingers Down (Press)**
The Three Finger-Flick gesture may be used to enhance navigation with a variety of applications such as browsing the Internet or scrolling through a photo viewer. The Three Fingers Down gesture may be used to launch user-selectable applications.

*Figure 2 - 16*
Flick/Press Gesture
Adding a Printer

The most commonly used peripheral is a printer. The following conventions will help you to add a printer; however it is always best to refer to the printer manual for specific instructions and configuration options.

USB Printer

Most new printers have a USB interface connection. You may use any one of the ports to connect the printer.

**Install Instructions:**
1. Set up the printer according to its instructions (unpacking, paper tray, toner/ink cartridge etc.).
2. Turn ON the computer.
3. Turn ON the printer.
4. Connect the printer’s USB cable to one of the USB ports on the computer.
5. **Windows** will identify the printer and either load one of its own drivers or ask you to supply one. Follow the on-screen instructions.

Parallel Printer

This is still a very common type of printer. The install instructions are in the sidebar (you will need to purchase a parallel to USB converter).

- **Parallel Printer**
  - After setting up the printer attach the parallel cable to the printer.
  - Connect the printer’s parallel cable to the Parallel to USB converter, and then plug the converter into the USB port.
  - Turn ON the printer, then turn ON the computer.
  - **Windows** will identify the printer and either load one of its own drivers or ask you to supply one. Follow the on-screen instructions.
Storage Devices, Mouse, Audio & Printer
Chapter 3: Power Management

Overview

To conserve power, especially when using the battery, your computer power management conserves power by controlling individual components of the computer (the monitor and hard disk drive) or the whole system.

This chapter covers:

- The Power Sources
- Turning On the Computer
- Power Plans
- Power-Saving States
- Configuring the Power Buttons
- Battery Information

The computer uses enhanced power saving techniques to give the operating system (OS) direct control over the power and thermal states of devices and processors. For example, this enables the OS to set devices into low-power states based on user settings and information from applications.

OS Note

Power management functions will vary slightly depending on your operating system. For more information it is best to refer to the user's manual of your operating system.

(Note: All pictures used on the following pages are from the Windows 7 OS.)
The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Use only the AC/DC adapter that comes with your computer. The wrong type of AC/DC adapter will damage the computer and its components (see page C - 4).

1. Attach the AC/DC adapter to the DC-In jack at the rear of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the AC/DC adapter.
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “On”.

Battery
The battery allows you to use your computer while you are on the road or when an electrical outlet is unavailable. Battery life varies depending on the applications and the configuration you're using. To increase battery life, let the battery discharge completely before recharging (see “How do I completely discharge the battery?” on page 3 - 14).

We recommend that you do not remove the battery. For more information on the battery, please refer to “Battery Information” on page 3 - 10.
Turning On the Computer

Now you are ready to begin using your computer. To turn it on simply press the power button on the front panel.

When the computer is on, you can use the power button as a Stand by/Hibernate/Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and holding the power button for longer than this will shut the computer down). Use Power Options in the Windows control panel to configure this feature.

Forced Off
If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press the power button for 4 seconds, or longer, to force the system to turn itself off.

Power Button as Stand by or Hibernate Button
You can use the OS’s Power Options control panel to set the power button to send the system into Stand by or Hibernate mode (see your OS’s documentation, or “Configuring the Power Buttons” on page 3 - 8 for details).

Shut Down
Note that you should always shut your computer down by choosing the Shut Down command from the bottom right of the Start menu in Windows. This will help prevent hard disk or system problems.
Power Plans

The computer can be configured to conserve power by means of power plans. You can use (or modify) an existing power plan, or create a new one.

The settings may be adjusted to set the display to turn off after a specified time, and to send the computer into Sleep after a period of inactivity.

Click Change plan settings and then click Change advanced power settings to access further configuration options in Advanced Settings.

Resuming Operation

See Table 3 - 1, on page 3 - 9 for information on how to resume from a power-saving state.

Password

It is recommended that you enable a password on system resume in order to protect your data.

Figure 3 - 1

Power Plan Advanced Settings (Win 7)
Each *Windows power plan* will also adjust the processor performance of your machine in order to save power. This is worth bearing in mind if you are experiencing any reduced performance (especially under DC/battery power).

Choose **High performance** (you may need to click *Show additional plans* to view the High performance plan) for maximum performance when the computer is powered from an AC power source. Choose the **Power saver** (bear in mind that this scheme may slow down the overall performance of the computer in order to save power) for maximum power saving when the computer is battery (DC power) powered.
Power Management

Power-Saving States

You can use power-saving states to stop the computer’s operation and restart where you left off. *Win 7* uses the Sleep, Hibernate and Shut Down power-saving states.

**Sleep**

In *Sleep* all of your work, settings and preferences are saved to memory before the system sleeps. When you are not using your computer for a certain length of time, which you specify in the operating system, it will enter *Sleep* to save power.

The PC wakes from *Sleep within seconds* and will return you to where you last left off (what was on your desktop) without reopening the application(s) and file(s) you last used.

If your mobile PC in *Sleep* is running on battery power the system will use only a minimum amount of power. After an extended period the system will save all the information to the hard disk and shut the computer down before the battery becomes depleted.
Hibernate

Hibernate uses the least amount of power of all the power-saving states and saves all of your information on a part of the hard disk before it turns the system off. If a power failure occurs the system can restore your work from the hard disk; if a power failure occurs when work is saved only to memory, then the work will be lost. Hibernate will also return you to where you last left off within seconds. You should put your mobile PC into Hibernate if you will not use the computer for a period of time, and will not have the chance to charge the battery.

Shut down

You should Shut down the computer if you plan to install new hardware (don’t forget to remove the battery and follow all the safety instructions in Chapter 6), plan to be away from the computer for several days, or you do not need it to wake up and run a scheduled task. Returning to full operation from Shut down takes longer than from Sleep or Hibernate.

Figure 3 - 3
Start Menu Power
Configuring the Power Buttons

The power/sleep button (Fn + F4 key combo) and closed lid may be set to send the computer into a power-saving state. Click **Choose what the power buttons do** on the left menu in **Power Options** to bring up the menu.

It is recommended that you enable a password on wake up in order to protect your data. However, you can disable this setting from the **Power Options** menu by clicking **Require a password on wakeup** in the left menu, and selecting the options (click **Change settings that are currently unavailable**).

---

**Figure 3 - 4**

Power Options
Define Power Buttons
Resuming Operation
You can resume operation from power-saving states by pressing the power button, or in some cases pressing the sleep button (Fn + F4 key combo).

<table>
<thead>
<tr>
<th>Power Status</th>
<th>Icon</th>
<th>Color</th>
<th>To Resume</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Off</td>
<td>Off</td>
<td></td>
<td>Press the Power Button</td>
</tr>
<tr>
<td>Sleep</td>
<td>Blinking Green</td>
<td></td>
<td>Press the Power Button</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Press the Sleep Button (Fn + F4 Key Combo)</td>
</tr>
<tr>
<td>Hibernate</td>
<td>Off (battery)</td>
<td>Orange (AC/DC adapter)</td>
<td>Press the Power Button</td>
</tr>
<tr>
<td>Display Turned Off</td>
<td>Green</td>
<td></td>
<td>Press a Key or Move the Mouse/Touchpad</td>
</tr>
</tbody>
</table>

Power Button
When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down hot key button when it is pressed for less than 4 seconds (pressing and holding the power button for longer than this will force the computer to shut down).

Closing the Lid
If you have chosen to send the computer to Sleep when the lid is closed, raising the lid will wake the system up.

Table 3 - 1
Resuming Operation
Battery Information

Follow these simple guidelines to get the best use out of your battery.

Battery Power

Your computer’s battery power is dependent upon many factors, including the programs you are running, and peripheral devices attached. You can set actions to be taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from power plan Change plan settings > Change advanced power settings (see Figure 3 - 1 on page 3 - 4).

Click the battery icon in the taskbar to see the current battery level and charge status.

Figure 3 - 5
Battery Icon (Taskbar) & Battery Advanced Settings
Conserving Battery Power

- Use a power plan that conserves power (e.g. Power saver), however note that this may have an effect on computer performance.
- Lower the brightness level of the LCD display. The system will decrease LCD brightness slightly to save power when it is not powered by the AC/DC adapter.
- Reduce the amount of time before the display is turned off.
- Close wireless, Bluetooth, modem or communication applications when they are not being used.
- Disconnect/remove any unnecessary external devices e.g. USB devices, ExpressCards etc.

Wireless Hot Keys

The computer’s wireless function keys will not function properly if Wireless is turned OFF in the Windows Mobility Center control panel.

The wireless indicators may show that the WLAN module is powered on, however if wireless is OFF in the Mobility Center, the module will not be powered on.

Make sure that Wireless is ON in the Mobility Center to ensure proper function key behavior.

Windows Mobility Center

The Windows Mobility Center control panel provides an easy point of access for information on battery status, power plans used and wireless device status etc.

Figure 3 - 6
Windows Mobility Center

Make sure Wireless is ON to ensure proper function key behavior.
Battery Life
Battery life may be shortened through improper maintenance. To optimize the life and improve its performance, fully discharge and recharge the battery at least once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to remove the battery for any reason (e.g. long term storage) see “Removing the Battery” on page 6 - 3.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ” on page 3 - 14 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and plugged into an electrical outlet. If the computer is powered on, and in use, it will take several hours to fully recharge the battery. When the computer is turned off but plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indicators” on page 1 - 7 for information on the battery charge status, and to “Battery Information” on page 3 - 10 for more information on how to maintain and properly recharge the battery pack.)
Proper handling of the Battery Pack

• DO NOT disassemble the battery pack under any circumstances.
• DO NOT expose the battery to fire or high temperatures, it may explode.
• DO NOT connect the metal terminals (+, -) to each other.

Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after being dropped), or any unusual smells emanating from the notebook battery, shut your computer down immediately and contact your service center. If the battery has been dropped we do not recommend using it any further, as even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly result in fire. It is recommended that you replace your computer battery every two years.

Caution

Danger of explosion if battery is incorrectly replaced.

Replace only with the same or equivalent type recommended by the manufacturer. Discard used battery according to the manufacturer’s instructions.
Battery FAQ

How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t turn off the computer even if a message indicates the battery is critically low, just let the computer use up all of the battery power and shut down on its own.

1. Save and close all files and applications.
2. **Create a power plan** for discharging the battery and set all the options to **Never**.
3. Click **Change plan settings** (after creating it) and click **Change plan settings > Change advanced power settings**.

![Figure 3 - 8 Change Plan Settings / Change Advanced Power Settings](image)
4. Scroll down to **Battery** and click + to expand the battery options.
5. Choose the options below (click **Yes** if a warning appears):

- Low battery levels = 0%
- Critical battery Levels = 1%
- Low battery action = Do Nothing
- Critical battery action (On battery) = Shut Down
- Critical battery action (Plugged in) = Do Nothing
How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges.

SLI Multi GPU Configuration & Battery Power

Note that due to the high power and system demands created by enabling SLI Configuration, you should not enable SLI configuration if your computer is powered by battery only. If you attempt to run an SLI configuration when the computer is powered by the battery only, then system problems may occur.

If the computer is currently powered by battery only do not enable SLI configuration.

If you have currently enabled SLI configuration, and the computer is powered by the AC/DC adapter, do not switch to battery power only (or go to the NVIDIA Control Panel and disable SLI configuration before switching to battery power only).
Power Management
Chapter 4: Drivers & Utilities

This chapter deals with installing the drivers and utilities essential to the operation or improvement of some of the computer’s subsystems. The system takes advantage of some newer hardware components for which the latest versions of most available operating systems haven’t built in drivers and utilities. Thus, some of the system components won’t be auto-configured with an appropriate driver or utility during operating system installation. Instead, you need to manually install some system-required drivers and utilities.

RAID & AHCI Setup
Note that setting up a RAID, or AHCI mode, needs to be done prior to installing the Windows OS, and therefore before installing the other drivers listed here (see “Setting Up SATA RAID Mode” on page 7 - 2).

What to Install
The Device Drivers & Utilities + User’s Manual disc contains the drivers and utilities necessary for the proper operation of the computer.

Table 4 - 1, on page 4 - 3 lists what you need to install and it is very important that the drivers are installed in the order indicated.

Module Driver Installation
The procedures for installing drivers for the WLAN, PC Camera, Consumer Infrared (for TV tuner remote), Intel Turbo Memory, HDMI-In and Fingerprint modules are provided in “Modules” on page 7 - 1.
Drivers & Utilities

Driver Installation

Insert the Device Drivers & Utilities + User’s Manual disc and click Install Drivers (button), or Option Drivers (button) to access the Optional driver menu.

1. Check the driver installation order from Table 4 - 1, on page 4 - 3 (the drivers must be installed in this order) which is the same as that listed in the Drivers Installer menu below.
2. Click to select the driver you wish to install, (you should note down the drivers as you install them).
3. Follow the instructions for each individual driver installation procedure as listed on the following pages.

Figure 4 - 1 - Drivers Installer Screen 1

Figure 4 - 2 - Drivers Installer Screen 2
<table>
<thead>
<tr>
<th>Windows 7 Driver</th>
<th>Page</th>
<th>Windows 7 Driver</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chipset</td>
<td>Page 4 - 6</td>
<td>Intel Turbo Memory &amp; Matrix Storage Setup and Driver Installation (for RAID)</td>
<td>Page 7 - 8</td>
</tr>
<tr>
<td>Video</td>
<td>Page 4 - 6</td>
<td>Wireless LAN Module</td>
<td>Page 7 - 18</td>
</tr>
<tr>
<td>LAN</td>
<td>Page 4 - 6</td>
<td>PC Camera Module</td>
<td>Page 7 - 36</td>
</tr>
<tr>
<td>Card Reader</td>
<td>Page 4 - 6</td>
<td>TV Tuner Module</td>
<td>Page 7 - 44</td>
</tr>
<tr>
<td>TouchPad</td>
<td>Page 4 - 7</td>
<td>Intel Turbo &amp; Matrix Storage Setup and Driver Installation (for Turbo Memory)</td>
<td>Page 7 - 56</td>
</tr>
<tr>
<td>USB 3.0</td>
<td>Page 4 - 7</td>
<td>HDMI-In Module (for optional HDMI-In Module)</td>
<td>Page 7 - 51</td>
</tr>
<tr>
<td>Hot Key</td>
<td>Page 4 - 7</td>
<td>Fingerprint Reader Module</td>
<td>Page 7 - 56</td>
</tr>
<tr>
<td>Audio</td>
<td>Page 4 - 7</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Table 4 - 1 - Driver Installation*
Drivers & Utilities

Manual Driver Installation
Click the **Browse CD/DVD** button in the **Drivers Installer** application and browse to the executable file in the appropriate driver folder.

Windows Update
After installing all the drivers make sure you enable **Windows Update** in order to get all the latest security updates etc. (all updates will include the latest **hotfixes** from Microsoft). See “**Windows Update**” on page 4 - 8 for instructions.

Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it may be necessary to uninstall the original driver. To do this go to the **Control Panel** in the **Windows OS** and double-click the **Programs and Features** icon (**Programs > Uninstall a program**). Click to select the driver (if it is not listed see below) and click **Uninstall**, and then follow the on screen prompts (it may be necessary to restart the computer). Reinstall the driver as outlined in this chapter.

If the driver is not listed in the **Programs and Features** menu:

1. Click **Start**, and click **Control Panel** (or point to **Settings** and click **Control Panel**).
2. Double-click **Device Manager** (**Hardware and Sound > Device Manager**).
3. Double-click the **device** you wish to update/reinstall the driver for (you may need to click “+” to expand the selection).
4. Click **Driver** (tab) and click the **Update Driver** or **Uninstall** button and follow the on screen prompts.
User Account Control
If a User Account Control prompt appears as part of the driver installation procedure, click Continue/Allow, and follow the installation procedure as directed.

Windows Security Message
If you receive a Windows security message as part of the driver installation process. Just click “Install this driver software anyway” or Install to continue the installation procedure.

You will receive this message in cases where the driver has been released after the version of Windows you are currently using. All the drivers provided will have already received certification for Windows.

New Hardware Found
If you see the message “New Hardware Found” during the installation procedure (other than when outlined in the driver install procedure), click Cancel to close the window, and follow the installation procedure.
Drivers & Utilities

Driver Installation Procedure
Insert the Device Drivers & Utilities + User’s Manual disc and click Install Drivers (button), or Option Drivers (button) to access the Optional driver menu.

RAID Note: Setting up a RAID, or AHCI mode, needs to be done prior to installing the Windows OS, and therefore before installing the other drivers listed here.

Chipset
1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

Video
1. Click 2.Install Video Driver > Yes.
2. Click Next > Next.
3. Click Finish to restart the computer.

LAN
1. Click 3.Install LAN Driver > Yes.
2. Click Install.
3. Click Finish to complete the installation.

Card Reader
1. Click 4.Install Cardreader Driver > Yes.
2. Click Install > Finish.

Driver Installation General Guidelines
The driver installation procedure outlined in this Chapter (and in Chapter 7 Options & Modules), are accurate at the time of going to press.

Drivers are always subject to upgrade and revision so the exact procedure for certain drivers may differ slightly. As a general guide follow the default on screen instructions for each driver (e.g. Next > Next > Finish) unless you are an advanced user. In many cases a restart is required to install the driver.
**TouchPad**
1. Click **5. Install Touchpad Driver > Yes.**
2. Click **Next.**
3. Click the button to accept the license, and then click **Next.**
4. Click **Finish > Restart Now** to restart the computer.

**USB 3.0**
1. Click **6. Install USB 3.0 Driver > Yes.**
2. Click **Next.**
3. Click the button to accept the license and then click **Next.**
4. Click **Next > Install.**
5. Click **Finish.**

**Hot Key**
1. Click **7. Install Hotkey AP > Yes.**
2. Click **Next > Next.**
3. Click **Finish > Finish** to restart your computer.

**Audio**
1. Click **8. Install Audio Driver > Yes.**
2. Click **Next.**
3. Click **Finish** to restart the computer.
After the drivers are installed follow this procedure to ensure an accurate rating from the *Windows Experience Index* (make sure the AC/DC adapter is plugged in):

1. Click **Start**, and click **Control Panel**.
2. Click **Performance Information and Tools** (*System and Security > System > Check the Windows Experience Index*).
3. Click “Rate this computer/Refresh Now/Re-run the assessment”.
4. The computer will take a few minutes to assess the system performance.
5. Close the control panel.

---

**Windows Update**

After installing all the drivers make sure you enable *Windows Update* in order to get all the latest security updates etc. (all updates will include the latest hotfixes from Microsoft).

To enable *Windows Update* make sure you are connected to the internet:

1. Click **Start**, and click **Control Panel** (or point to **Settings** and click **Control Panel**).
2. Click **Windows Update** (*System and Security/Security*).
3. Click **Check for updates** (button).
4. The computer will now check for updates (you need to be connected to the internet).
5. Click **Install now** (button) to begin checking for the updates.
6. Click **Install updates** (button) to install the updates.
Optional Drivers
See the pages indicated for the driver installation procedures for any modules included in your purchase option.

Figure 4-3 - Optional Drivers Installer Screen

RAID Setup
Note: Prior to setting up the RAID you will need to use an operable computer to copy the RAID driver to a USB flash drive before installing the Windows operating system. See “Setting Up SATA RAID Mode” on page 7-2 for configuration instructions.

Bluetooth Module
Note: The operating system is the default setting for Bluetooth control in Windows 7, and does not require a driver. See “Bluetooth Module” on page 7-12 for configuration instructions.

Wireless LAN
See the appropriate install procedure for your WLAN module in “Wireless LAN Module” on page 7-17.

PC Camera
See the install procedure in “PC Camera Module” on page 7-35.
<table>
<thead>
<tr>
<th>Drivers &amp; Utilities</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Consumer Infrared (for TV Tuner Remote)</strong></td>
<td>See the install procedure in “TV Tuner Module” on page 7 - 43.</td>
</tr>
<tr>
<td><strong>Turbo Memory Module</strong></td>
<td>See the install procedure in “Intel Turbo Memory Module” on page 7 - 46.</td>
</tr>
<tr>
<td><strong>HDMI-In Driver</strong></td>
<td>See the install procedure in “HDMI-In Module” on page 7 - 51.</td>
</tr>
<tr>
<td><strong>Fingerprint Reader Module</strong></td>
<td>See the install procedure in “Fingerprint Reader Module” on page 7 - 55.</td>
</tr>
</tbody>
</table>
Chapter 5: BIOS Utilities

Overview

This chapter gives a brief introduction to the computer’s built-in software:

**Diagnostics:** The POST (Power-On Self Test)

**Configuration:** The **Setup** utility

If your computer has never been set up, or you are making important changes to the system (e.g. hard disk setup), then you should review this chapter first and note the original settings found in **Setup**. Even if you are a beginner, keep a record of the settings you find and any changes you make. This information could be useful if your system ever needs servicing.

There is one general rule: *Don’t make any changes unless you are sure of what you are doing.* Many of the settings are required by the system, and changing them could cause it to become unstable or worse. If you have any doubts, consult your service representative.
The Power-On Self Test (POST)

If you enable the **Boot-time Diagnostic Screen** in the Setup Utility, each time you turn on the computer the system takes a few seconds to conduct a **POST**, including a quick test of the on-board RAM (memory).

As the **POST** proceeds, the computer will tell you if there is anything wrong. If there is a problem that prevents the system from booting, it will display a system summary and prompt you to run **Setup**.

If there are no problems, the **Setup** prompt will disappear and the system will load the operating system. Once that starts, you can’t get into **Setup** without rebooting.

**Note:** The **POST** screen as pictured right is for guideline purposes only. The **POST** screen on your computer may appear slightly different. If the **Boot-time Diagnostic Screen** is disabled (see page 5 - 9 as per the default setting), the **POST** screen will not appear.

---

**Figure 5 - 1**
**POST Screen**

1. BIOS information
2. CPU type
3. Memory status
4. Enter **Setup** prompt

**Press <F2> to enter **Setup**.**

**POST Screen**

- BIOS information
- CPU type
- Memory status
- Enter Setup prompt

Note: The POST screen as pictured right is for guideline purposes only. The POST screen on your computer may appear slightly different. If the Boot-time Diagnostic Screen is disabled (see page 5 - 9 as per the default setting), the POST screen will not appear.
Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “non-fatal”.

Fatal Errors
These stop the boot process and usually indicate there is something seriously wrong with your system. Take the computer to your service representative or authorized service center as soon as possible.

Non-Fatal Errors
This kind of error still allows you to boot. You will get a message identifying the problem (make a note of this message!) followed by the prompt:

• Press <F1> to resume
• <F2> to enter Setup

Press F1 to see if the boot process can continue. It may work, without the correct configuration.

Press F2 to run the Setup program and try to correct the problem. If you still get an error message after you change the setting, or if the “cure” seems even worse, call for help.
The Setup Utility

The Phoenix Setup utility tells the system how to configure itself and manage basic features and subsystems (e.g. port configuration).

Entering Setup

To enter Setup, turn on the computer and press F2 during the POST. The prompt (Press F2 to Enter Setup) seen in Figure 5 - 1 on page 5 - 2 is usually present for a few seconds after you turn on the system. If you get a “Keyboard Error”, (usually because you pressed F2 too quickly) just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and then hold down F2 when prompted. The Setup main menu will appear.
Setup Screens
The following pages contain additional advice on portions of the **Setup**.

Along the top of the screen is a menu bar with menu headings. When you select a heading, a new screen appears. Scroll through the features listed on each screen to make changes to **Setup**.

Instructions on how to navigate each screen are in the box along the bottom of the screen. If these tools are confusing, press **F1** to call up a **General Help** screen, and then use the arrow keys to scroll up or down the page.

The **Item Specific Help** on the right side of each screen explains the highlighted item and has useful messages about its options.

If you see an arrow ▶ next to an item, press **Enter** to go to a sub-menu on that subject. The sub-menu screen that appears has a similar layout, but the **Enter** key may execute a command.
System Time & Date (Main Menu)
The hour setting uses the 24-hour system (i.e., 00 = midnight; 13 = 1 pm). If you can change the date and time settings in your operating system, you will also change these settings. Some applications may also alter data files to reflect these changes.
System/Extended Memory: (Main Menu)
This item contains information on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.

BIOS Revision/VGA Card etc. (Main Menu)
This item contains information on the BIOS version and video card etc., and is not user configurable.
Advanced Menu

Advanced Chipset Control (Advanced Menu)
The sub-menu here allows you to enable/disable some advanced system features.
**SATA Mode Selection (Advanced Menu)**
You may enable/disable SATA RAID or AHCI mode for your hard disks, however you should only enable/disable SATA RAID or AHCI BEFORE installing an operating system, and after you have backed up all necessary files and data (see sidebar). See “Setting Up SATA RAID Mode” on page 7 - 2 for details.

**Legacy USB Support: (Advanced Menu)**
Choose “Enabled” if you intend to use USB devices in systems which do not normally support USB functionality (e.g. DOS). The default setting is “Enabled” and does not need to be changed if you intend to use your USB devices in Windows.

**Boot-time Diagnostic Screen: (Advanced Menu)**
Use this menu item to enable/disable the Boot-time Diagnostic Screen. Enable this item to display the POST screen (see “The Power-On Self Test (POST)” on page 5 - 2).

**Reset Configuration Data (Advanced Menu)**
This item is set to No as default. You can change the setting to Yes if you have installed a new add-on which has reconfigured the system, resulting in such a serious system conflict that the operating system is unable to boot.
BIOS Utilities

Power On Boot Beep (Advanced Menu)
Use this menu item to enable/disable the beep as the computer starts up.

Battery Low Alarm Beep: (Advanced Menu)
Use this menu item to enable/disable the battery low alarm beep.
Bluetooth Power Setting > Advanced Chipset Control

You can adjust the Bluetooth module power setting to your preference. The default setting *(Disabled)* will see the Bluetooth module powered off when the system is started up or restarted. Enabling the power setting will have the module retain the last power status (on or off) before any restart or shut down.
Intel Virtualization Technology > Advanced Chipset Control

*Intel(R) Virtualization Technology* enables a CPU to act as if it were several CPUs working in parallel in order to allow several operating systems to run at the same time in the same machine.

Hyperthreading > Advanced Chipset Control

*Hyperthreading* activates additional CPU threads that may appear as additional processors and is used to improve CPU multi-tasking. The operating system will view a processor with *Hyperthreading* enabled as two virtual processors and will spread any tasks between them (make sure your installed operating system supports multiple processors, and preferably, is optimized for this technology). After enabling/disabling *Hyperthreading*, and saving and exiting the BIOS, the system will shut down (press the power button to turn the system on again).

CPU C State > Advanced Chipset Control

Enable/Disable CPU C States (operating states) here.

Turbo Boost > Advanced Chipset Control

You can enable Turbo Boost to automatically run the processor core faster than the stated frequency (within specification limits of the Thermal Design Power) for increased performance.
Security Menu

Set Supervisor Password (Security Menu)
You can set a password for access to the Phoenix SecureCore Setup Utility. This will not affect access to the computer OS (only the Phoenix SecureCore Setup Utility).

Figure 5 - 5
Security Menu

The changes you make here affect the access to the Setup utility itself, and also access to your machine as it boots up after you turn it on. These settings do not affect your machine or network passwords which will be set in your software OS.
Set User Password (Security Menu)
You can set a password for user mode access to the Phoenix SecureCore Setup Utility. This will not affect access to the computer OS, (only the Setup utility) unless you choose to set a Password on Boot (see below). Many menu items in the Phoenix SecureCore Setup Utility cannot be modified in user mode. You can only set the user password after you have set the supervisor password.

Password on boot (Security Menu)
Specify whether or not a password should be entered to boot the computer (you may only set a password on boot if a supervisor password is enabled). If “Enabled” is selected, only users who enter a correct password can boot the system (see the warning in the sidebar). The default setting is “Disabled”.

Note: To clear existing passwords press Enter and type the existing password, then press Enter for the new password (without typing any password entry) and Enter again to confirm the password clearance.
When you turn the computer on it will look for an operating system (e.g. Windows 7) from the devices listed in this menu, and in this priority order. If it cannot find the operating system on that device, it will try to load it from the next device in the order specified in the Boot priority order. Item specific help on the right is available to help you move devices up and down the order.
Choosing to **Discard Changes**, or **Exit Discarding Changes**, will wipe out any changes you have made to the **Setup**. You can also choose to restore the original **Setup** defaults that will return the **Setup** to its original state, and erase any previous changes you have made in a previous session.
Chapter 6: Upgrading The Computer

Overview

This chapter contains information on upgrading the computer. Follow the steps outlined to make the desired upgrades. If you have any trouble or problems you can contact your service representative for further help. Before you begin you will need:

• A small crosshead or Phillips screwdriver
• A small regular slotted (flathead) screwdriver
• An antistatic wrist strap

Before working with the internal components you will need to wear an antistatic wrist strap to ground yourself because static electricity may damage the components.

The chapter includes:

• Removing the Battery
• Upgrading the Hard Disk Drive(s)
• Upgrading the Optical (CD/DVD) Device
• Upgrading the System Memory (RAM)

Please make sure that you review each procedure before you perform it.
When Not to Upgrade

These procedures involve opening the system’s case, adding and sometimes replacing parts. You should **not** perform any of these upgrades if:

- Your system is still under warranty or a service contract
- You don’t have all the necessary equipment
- You’re not in the correct environment
- You doubt your abilities

Under any of these conditions, contact your service representative to purchase or replace the component(s).

Upgrading the Processor

If you want to upgrade your computer by replacing the existing processor with a faster/new one you will need to contact your customer service representative. We recommend that you do not do this yourself, since if it is done incorrectly you may damage the processor or mainboard.
Removing the Battery

If you are confident in undertaking upgrade procedures yourself, for safety reasons it is best to remove the battery. **Before removing the battery disconnect the AC/DC adapter from the computer first.**

1. Turn the computer off, remove the AC/DC adapter and turn it over.
2. Loosen screws 1 - 3 and carefully lift the battery 4 up.
3. Remove the battery from the battery bay.

**Warranty Warning**
Please check with your service representative before undertaking any upgrade procedures to find out if this will VOID your warranty.

*Figure 6 - 1*
Battery Removal
Upgrading the Hard Disk Drive(s)

The hard disk drive(s) can be taken out to accommodate other 2.5" serial (SATA) hard disk drives with a height of 9.5mm (h) (see “Storage” on page C - 2). Follow your operating system’s installation instructions, and install all necessary drivers and utilities (as outlined in “Drivers & Utilities” on page 4 - 1), when setting up a new hard disk.

HDD System Warning

New HDD’s are blank. Before you begin make sure:
You have backed up any data you want to keep from your old HDD.
You have all the CD-ROMs and FDDs required to install your operating system and programs.
If you have access to the internet, download the latest application and hardware driver updates for the operating system you plan to install. Copy these to a removable medium.
Removing the Hard Disk(s) from the Primary HDD Bay
1. Turn the computer off, remove the AC/DC adapter, turn it over and remove the battery.
2. Locate the hard disk bay cover and remove screws 1 & 2.
3. Remove the hard disk bay cover 3.

RAID Hard Disks
All hard disks in a RAID should be identical (the same size and brand) in order to prevent unexpected system behavior.

Figure 6 - 2
Primary HDD Bay Cover Screws & Cover Removal
Upgrading The Computer

4. Disconnect the HDD cable ④.
5. Remove screws ⑤ - ⑧ from the hard disk assembly.
6. Pull the tab ⑨ to disconnect the hard disk assembly from the connector.
7. Remove the hard disk assembly ⑩.
8. Remove the HDD board & cable ⑪.

Figure 6 - 3
Hard Disk Assembly
Screws & Removal

Mustang W650 Notebook

6 - 6 Upgrading the Hard Disk Drive(s)
9. Remove screws 12 - 15 (depending on how many hard disks you have installed in the assembly).
10. Remove the hard disk(s) 16 from the case.

Figure 6 - 4
Hard Disk(s) Removal
Upgrading The Computer

11. If two hard disks are installed then an insulation plate will be installed on the upper hard disk.
12. Remove screws 17 - 20 and the insulation plate 21.
13. Reverse the process to install any new disk(s) and do not forget to install the insulation plate (onto the upper hard disk in the orientation illustrated below), screws, cables and covers (pay careful attention to the orientation of the hard disks in the case).

Figure 6 - 5
Upper HDD Insulation Plate Removal
Inserting the Primary Hard Disk(s)
1. Insert the HDD(s) 1 into the case as illustrated (make sure the cable connectors are facing towards the gap at the rear of the case, and that the upper HDD insulation plate is installed).
2. Insert screws 2 - 5 to secure the hard disk(s) in the case.

Figure 6 - 6
HDD Insertion & Screws
3. Firmly insert the HDD cable (6) into the hard disk case (7) as indicated below.
4. Insert the HDD assembly into the bay by pushing it straight down (do not insert the assembly at an angle).
5. Firmly connect cable (8) and then secure the assembly with screws (9 - 12).
Upgrading The Computer

Removing the Hard Disk from the Secondary HDD Bay
1. Remove the battery (the Secondary hard disk bay is located under the battery).
2. Remove screws 1 - 4 from the hard disk assembly.
3. Grip the tab and slide the hard disk assembly in the direction of the arrow 5.
4. Lift the hard disk assembly out of the compartment.

Figure 6 - 8
Secondary HDD Assembly Removal
5. Remove screws 6 - 9 from the hard disk assembly.
6. Separate the HDD 10 from the case 11.
7. Insert the replacement HDD into the case (make sure the cable connector is facing towards the rear of the case as illustrated below).
9. Insert the HDD assembly into the bay by pushing it straight down (do not insert the assembly at an angle) and then slide it in the direction of arrow 12 to lock in place.

Figure 6 - 9
Secondary HDD Assembly Removal
Upgrading the Optical (CD/DVD) Device

1. Locate the hard disk bay cover and remove screws 1 & 2.
2. Remove the hard disk bay cover 3.
3. Remove the screw at point 4, and use a screwdriver to carefully push out the optical device at point 5.
4. Reverse the process to install any new optical device.
Upgrading The Computer

Upgrading the System Memory (RAM)

The computer has three memory sockets for 204 pin Small Outline Dual In-line (SO-DIMM) DDR III (DDR3) type memory modules (see “Memory” on page C-2). The total memory size is automatically detected by the POST routine once you turn on your computer.

1. Turn off the computer, and turn it over and remove the battery.
2. Remove screws 1 & 2 from the bottom of the computer.

Figure 6-11
LED Module Screws
Upgrading The Computer

3. Turn the computer over, open the Lid/LCD, and carefully (a cable is connected to the underside of the LED cover module) unsnap up the LED cover module from point 3 on the right.

4. Disconnect cable 4 and remove the LED cover module 5.

Figure 6 - 12
LED Cover Module Removal

Figure 6 - 13
LED Cover Module Cable Disconnect
Upgrading The Computer

5. Remove screws 6 - 10 from the keyboard.

Figure 6 - 14
Keyboard Screws

6. Carefully lift the keyboard up, being careful not to bend the keyboard ribbon cable.
7. Disconnect the keyboard ribbon cable 11 from the locking collar socket 12.

Figure 6 - 15
Disconnect the Keyboard Locking Collar

6 - 16 Upgrading the System Memory (RAM)
8. Remove the keyboard 13.
9. Remove screws 14 - 16 from the keyboard shielding plate.

Figure 6 - 16
Keyboard Removal

Figure 6 - 17
Keyboard Shielding Plate Screws
Upgrading The Computer

10. Lift the keyboard shielding plate up in the direction of the arrow 17.
11. Remove the keyboard shielding plate 18.

Figure 6 - 18
Keyboard Shielding Plate Up

Figure 6 - 19
Keyboard Shielding Plate Remove

6 - 18 Upgrading the System Memory (RAM)
12. Gently pull the two release latches (19 & 20) on the sides of the memory socket(s) in the direction indicated below.
13. The RAM module 21 will pop-up, and you can remove it.

14. Pull the latches to release the second module if necessary.
15. Insert a new module holding it at about a 30° angle and fit the connectors firmly into the memory socket.
16. The module’s pin alignment will allow it to only fit one way. Make sure the module is seated as far into the socket as it will go. DO NOT FORCE the module; it should fit without much pressure.
17. Press the module in and down towards the mainboard until the socket levers click into place to secure the module.
18. Replace the shielding plate (see over) screws, keyboard (reconnect the keyboard cable) and LED cover module (see the preceding pages).
Keyboard Shielding Plate Insertion
1. When re-inserting the keyboard shielding plate make sure you insert it by sliding it into position at an angle as illustrated by arrow below, and press it down into position.
2. Secure the plate with screws.

Figure 6 - 21
Keyboard Shielding Plate Insertion
Chapter 7: Modules

Overview

This chapter contains the information on the various modules (some of which are optional) which may come with your computer, depending on the configuration purchased. If you are unsure please contact your service representative.

The chapter includes information on the following:

• Setting Up SATA RAID Mode
• Bluetooth Module
• Wireless LAN Module
• PC Camera Module
• TV Tuner Module
• Intel Turbo Memory Module
• HDMI-In Module
• Fingerprint Reader Module
Setting Up SATA RAID Mode

AHCI Mode
Advanced Host Controller Interface (AHCI) is an interface specification that allows the storage driver to enable advanced serial ATA features such as Native Command Queuing (for maximum hard disk efficiency and performance). AHCI mode can be supported by one, two or three hard disks.

RAID
To configure your system in Striping (RAID 0) or Mirroring (RAID 1) modes (see Table 7 - 1, on page 7 - 3) you will require at least two identical (see sidebar) hard disks; to configure your system in Intel® Rapid Recover Technology (Recovery) mode you will require two hard disks installed; to configure your system in Parity Across Disks (RAID 5) mode you will require three hard disks installed.

Intel® Matrix Storage Manager
Make sure you install the Intel Matrix driver and application if you have set up your hard disk(s) in RAID mode (see “Intel Turbo Memory & Matrix Storage Setup and Driver Installation” on page 7 - 8).
Prepare the following before setting up your serial ATA hard disks in RAID mode:

1. The **Microsoft Windows 7 OS DVD**.
2. A **second** (identical) hard disk installed in the Primary HDD bay.
   OR
   A **second** (identical) hard disk installed in the Primary HDD bay, and a **third** (identical) hard disk in the Secondary HDD bay if required.

### RAID Levels

<table>
<thead>
<tr>
<th>RAID Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAID 0</td>
<td>Identical drives reading and writing data in parallel to <strong>increase performance</strong>. RAID 0 implements a striped disk array and the data is broken into blocks and each block is written to a separate disk drive.</td>
</tr>
<tr>
<td>RAID 1</td>
<td>Identical drives in a mirrored configuration used to <strong>protect data</strong>. Should a drive that is part of a mirrored array fail, the mirrored drive (which contains identical data) will handle all the data. When a new replacement drive is installed, data to the new drive is rebuilt from the mirrored drive to restore fault tolerance.</td>
</tr>
<tr>
<td>RAID 5</td>
<td>Identical drives (at least <strong>three</strong> drives must be used) in a parity across disks configuration are used to <strong>protect data</strong> and <strong>increase performance</strong>. A RAID 5 array can withstand a single disk failure without losing access to data.</td>
</tr>
<tr>
<td>Recovery</td>
<td>Two Identical drives copying data between a master and a recovery disk. This provides more control over how data is copied between the master and recovery drives, fast volume updates and the ability to view the data in <strong>Windows Explorer</strong>.</td>
</tr>
</tbody>
</table>

### Array Types

**A Mirrored Array** (RAID 1) provides full data protection, as data can simply be copied from a healthy disk to a replacement for any failed disk.

**A Striped Array** (RAID 0) is **NOT** fault-tolerant. The failure of one drive will result in the loss of all data in the array. It is designed to increase disk performance by spreading the I/O load across the channels and drives.
SATA RAID Setup Procedure (BIOS)

1. Start-up your notebook computer and press <F2> to enter the BIOS.
2. Go to the Advanced menu, select "SATA Mode Selection" and press Enter (see page 5 - 8).
   - Select “RAID”.
3. Press Esc and go to the Boot menu.
4. Set the DVD-ROM Drive (make sure the Microsoft Windows 7 OS DVD is inserted) as the first device in the boot order from the Boot menu (see “Boot Menu” on page 5 - 15).
5. Select Exit Saving Changes from the Exit menu (or press F10 and Enter) and press Enter to exit the BIOS and reboot the computer.
6. See the instructions in “RAID Setup (Intel Matrix)” on page 7 - 5.
RAID Setup (Intel Matrix)

1. As the computer starts up press Ctrl + i to enter RAID configuration menu.


3. Type the RAID volume name and then press Tab or Enter to advance to the next field.

4. Specify (use the up and down arrow keys) the RAID level (RAID 0, RAID 1, RAID 5 or Recovery - see Table 7 - 1, on page 7 - 3) and then press Tab or Enter to advance to the next field.

Figure 7 - 1
Intel(R) Rapid Storage Technology Option ROM

Recovery Level
When selecting disks for the Recovery RAID level you will need to use the Tab key to select a Master disk, and the Space key to select a Recovery disk.

You can select the synchronization between the disks to be Continuous (automatic) or On Request (manually).
5. Press Enter and the system will select the physical disks to use.
6. Press Enter and select (if applicable) the Strip Size (best set to default).
7. Press Enter and select the Capacity size (best set to default).
8. Press Enter to select **Create Volume**.
9. Press Enter to create the volume, and confirm the selection by pressing **Y**.
10. This will now return to the main menu.

**Recovery Level**

When selecting disks for the Recovery RAID level you will need to use the **Tab** key to select a **Master** disk, and the **Space** key to select a **Recovery** disk.

You can select the synchronization between the disks to be **Continuous** (automatic) or **On Request** (manually).

**Figure 7 - 2**

RAID Created

11. Select **5.Exit** and press Enter, then press **Y** to exit the RAID configuration menu.
12. Make sure the **Windows 7** OS DVD is in the DVD drive. and as the computer starts up it will automatically boot from the **Windows 7** OS DVD.

13. Press **Enter** to continue installing the operating system as normal (see your **Windows** documentation if you need help on installing the **Windows** OS).

14. Install the **Windows** drivers from the **Device Drivers & Utilities + User’s Manual** disc as per **Table 4 - 1, on page 4 - 3** (make sure you install the Intel Matrix driver - see “**Intel Turbo Memory & Matrix Storage Setup and Driver Installation**” on page 7 - 8).
Intel Turbo Memory & Matrix Storage Setup and Driver Installation

1. Insert the *Device Drivers & Utilities + User’s Manual* disc into the CD/DVD drive.
2. Click *Option Drivers* (button).
3. Click *4.Install TM&iMSM Driver > Yes*.
4. Click *Next > Next > Yes > Next*.
5. Click *Finish* to restart the computer.

The *Intel Matrix Storage Console* displays status information on your RAID configuration. Run the *Intel® Matrix Storage Console* from the *Intel® Matrix Storage Manager* in the Programs/All Programs menu. The *Intel® Matrix Storage Manager* provides information on the RAID status.

![Figure 7-3](image-url)
*Figure 7-3* Intel Matrix Storage Console (Basic & Advanced Views)
Intel® Matrix Storage Manager

If a hard drive member of a RAID volume is reported as “**Degraded**” or “**Failed**” it may be possible to recover the volume. If the volume cannot be restored then you will need to recreate the RAID volume and restore the data from a back up. The **Help** menu (press F1 or select **Contents and Index** from the **Help** menu) provides instructions on how to recover or recreate RAID Volumes.

**Figure 7 - 4**
Intel Matrix Storage Manager Help
RAID Volume Data Verification and Repair

The RAID volume data verification process identifies any inconsistencies or bad data on a RAID 0 or RAID 1 volume. The table outlines what occurs for each RAID level:

<table>
<thead>
<tr>
<th>RAID Level</th>
<th>Verify</th>
<th>Verify &amp; Repair</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAID 0</td>
<td>Bad blocks are identified.</td>
<td>N/A</td>
</tr>
</tbody>
</table>
| RAID 1     | Bad blocks are identified.  
Data on the mirrored drive is compared to data on the source drive. | Bad blocks are reassigned.  
If the data on the mirrored drive does not match the data on the source drive, the data on the mirrored drive is overwritten by the data on the source. |
| RAID 5     | Bad blocks are identified.  
Parity is recalculated and compared to the stored parity for that stripe. | Bad blocks are reassigned.  
If the newly calculated parity does not match the stored parity, the stored parity is overwritten with the newly calculated parity. |

Replacing and Reverting Recovery and Master Volumes

If a master or recovery drive fails you will need to add a new identical drive and rebuild the recovery volume to the drive. You can also revert the master drive to the state of the previous volume update. For details on how to do this see “Intel Matrix Storage Manager Help” on page 7 - 9.

See over for details on how to verify and repair RAID volume data.
Verifying and Repairing RAID Volume Data

1. Run the Intel® Matrix Storage Console from the Intel® Matrix Storage Manager in the Programs/All Programs menu.
2. Click View > Advanced Mode.
3. Right-click on the RAID volume and select either Verify Volume Data or Verify and Repair Volume Data.
4. The verification or verification and repair process will run and display progress.
5. A dialog box will display the final status of the verification or verification and repair status.

Figure 7 - 5
RAID Verification
(Intel® Matrix Storage Console)
Bluetooth Module

The optional Bluetooth module allows you to connect your computer to Bluetooth enabled devices such as other computers, desktop computers, mobile phones, printers, digital cameras, PDAs, headsets etc. using a short-range radio frequency.

Use the **Fn + F12 key combination** or **Touch Sensor Instant Key** to toggle power to the Bluetooth module. When the Bluetooth module is powered on, the touch sensor 📞 LED will be highlighted and the indicator 📞 will briefly be displayed. The operating system’s **Bluetooth Devices** control panel is used to configure the Bluetooth settings in **Windows**, and therefore does not require a driver.

### Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is supported in **one direction only (simultaneous data transfer is not supported)**. Therefore if you are copying a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from the Bluetooth enabled device to your computer until the file transfer process from the computer has been completed.

### Bluetooth Module & Resuming From Sleep Mode

The Bluetooth module’s default state will be off after resuming from the **Sleep** power-saving state. Use the key combination (**Fn + F12**) to power on the Bluetooth module after the computer resumes from Sleep.
Bluetooth Configuration in Windows 7

Setup your Bluetooth Device so the Computer Can Find it
1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
2. Make the device discoverable (to do this check your device documentation).

To Turn the Bluetooth Module On
1. Press the **Fn + F12** key combination to power on the Bluetooth module.
2. A Bluetooth icon \(\mathcal{B}\) will appear in the taskbar.
3. You can then do any of the following to access the **Bluetooth Devices** control panel.
   - **Double-click** the taskbar icon \(\mathcal{B}\) to access the **Bluetooth Devices** control panel.
   - **Click/Right-click** the taskbar icon \(\mathcal{B}\) and choose an option from the menu.

![Add a device](image1)

**Add a Device**
Click **Start**, and click **Control Panel** and then click **Devices and Printers (Hardware and Sound)**. Click **Add a device** to search for any available Bluetooth devices.

If you are experiencing problems connecting to some Bluetooth devices see ‘’ on page 8 - 14.’’

![Right-Click Taskbar Icon](image2)

---

Figure 7 - 6
**Bluetooth Devices & Click Icon Menu**
To Add a Bluetooth Device
1. Access the Bluetooth Devices control panel and click Add a device.
2. Double-click the device you want to pair with the computer.
3. On first connection the computer will provide you with a pairing code to be entered onto the device.

Pairing Options
If a device has been previously connected then the pairing option menu will appear when you attempt subsequent connections. You can choose to have the computer create a pairing code for you, use the device’s existing pairing code or you can pair certain devices without using a code.
4. Enter the code into your Bluetooth enabled device and follow any on-screen instructions to complete the pairing.

5. **Windows** will check to see if any drivers are required to complete the pairing.
6. Follow any on-screen instructions on the computer if device drivers are required to be installed.
7. Click **Close**.

---

**Pairing Codes**

The example outlined here shows a connection to a mobile device. Other devices e.g. computers, may have a slightly different connection procedure, and may require you to confirm a pairing code is correct on both devices. Follow the on-screen instructions to complete the pairing.
To Change Settings for the Bluetooth Device
1. Click the taskbar icon and select Show Bluetooth Devices.
2. Right-click on the device you want to change and click Properties to:
   • Change the name of the device (click Bluetooth, type a new name and click OK).
   • Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

To Make your Computer Discoverable to Bluetooth Devices
1. Click the taskbar icon and select Open Settings.
2. Click Options, and make sure that Allow Bluetooth devices to find this computer check box (Discovery) has a tick inside it.
3. Make sure that the Alert me when a new Bluetooth device wants to connect check box (Connections) has a tick inside it, if you want to be notified when a Bluetooth device wants to connect.

Figure 7 - 10
Bluetooth Settings - Options
Wireless LAN Module

If you have included an Intel® Advanced N Wi-Fi Link 6200, Intel® Ultimate N Wi-Fi Link 6300 module or 3rd Party 802.11b/g/n WLAN module in your purchase option, make sure that the Wireless LAN module is on before installing the driver.

Use the Fn + F11 key combination or Touch Sensor Instant Key to toggle power to the Wireless LAN module. When the WLAN module is powered on, the touch sensor (şı) LED will be highlighted and the indicator (şë) will briefly be displayed. Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3. The operating system is the default setting for Wireless LAN control in Windows 7.

Wireless should be turned ON in the Windows Mobility Center to ensure proper wireless function key behavior (see “Wireless Hot Keys” on page 7 - 34).
Modules

Intel® Wi-Fi Link Series Driver Installation
If you see the message “Found New Hardware” click Cancel to close the window.

1. Make sure the module is powered on, then insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive.
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Click Next > Next.
5. Click the button to accept the license and click Next.
6. Click Next > Next > Finish.

Note: The operating system is the default setting for Wireless LAN control in Windows (see overleaf).

802.11b/g/n Driver Installation
1. Make sure the module is powered on, then insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive.
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Choose the language you prefer and click Next.
5. Click Next > Install.
6. Click Finish to restart the computer.

Note: The operating system is the default setting for Wireless LAN control in Windows 7 (see overleaf).

Intel(R) PROSet/Wireless
Access the Intel PROSet Wireless tools (Statistics and Diagnostic tools) from the Start menu (Start > Programs/All Programs > Intel PROSet Wireless). These tools provide diagnostic and statistical information only (use the WLAN control in Windows to connect to a WLAN access point).
Connecting to a Wireless Network in Windows 7

Make sure the Wireless LAN module is turned on.

1. **Click** the taskbar wireless icon, and then double-click an access point to connect to or click to **Open Network and Sharing Center** if you do not see a network you want to connect to in the taskbar menu (a list of options will appear allowing setting changes, and creating a new network).

Network and Sharing Center

You can also use the Network and Sharing Center control panel in Windows (Network and Internet) to connect to any available wireless networks.

![Wireless Network Connection](image)

**Figure 7 - 11**
Click Taskbar Icon Menu & Network and Sharing Center
2. You may need to enter a security key for any access point to which you are trying to connect.
3. Click to select a network location (e.g. Home, Work or Public).
4. Click “View or change settings in Network and Sharing Center” to access further options for the connection.

Figure 7 - 12
Network Location
Set
5. Click the taskbar icon to see any currently connected networks.
6. To disconnect from the wireless network you can click the taskbar wireless icon, click the active connection and then click Disconnect (button).

Security Enabled Networks
You should try to make sure that any network you are connecting to is a secure network.

Connecting to unsecure networks may allow unauthorized access to your computer, documents, websites and files etc.

Figure 7 - 13
Click Taskbar Icon
Menu - Disconnect
Intel® My WiFi Configuration

Intel® My WiFi Technology uses your WLAN (for Intel WLAN modules only) module to allow you to connect up to eight other WiFi enabled devices (e.g. digital cameras, other computers, cell phones, handheld devices etc.) to your computer (similar to Bluetooth), while still connecting to the Internet through your WiFi wireless connection. Intel® My WiFi Technology offers greater range and speed than other personal area networks, and does not require an access point.

To get help on Intel® My WiFi configuration and settings, access the Intel® My WiFi Utility from the Start menu (Start > Programs/All Programs > Intel PRO-Set Wireless > Intel My WiFi Technology), or by clicking the taskbar icon. Click the Help icon and select a help topic from the Contents menu.
Intel® My WiFi Configuration
You can configure the My WiFi settings as follows.

1. Access the Intel® My WiFi Utility from the Start menu (Start > Programs/All Programs > Intel PROSet Wireless > Intel My WiFi Technology), or by double-clicking the taskbar icon .
2. Click Enable (on the first run of the program there will be no connected devices listed).
3. Click **Start** and click **Control Panel**.
4. Click **Network and Sharing Center (Network and Internet)**.
5. Click **Change adapter settings**.

![Figure 7 - 15 Network and Sharing Center](image)

Click **Change adapter settings**

---

**Modules**

7. 24 Wireless LAN Module

*Mustang W650 Notebook*
6. Right-click **Wireless Network Connection** and select **Properties**.

*Figure 7 - 16: Network Connections*
7. Click **Sharing (tab)** and select "**Allow other network users to connect through this computer’s Internet connection**".
8. Select **Wireless Network Connection** under **Home networking connection**.
9. Click **OK**.

![Wireless Network Connection Properties - Sharing](image)

**Figure 7 - 17**
Wireless Network Connection Properties - Sharing
10. Access the Intel® My WiFi Utility from the Start menu (Start > Programs/All Programs > Intel PROSet Wireless > Intel My WiFi Technology), or by double-clicking the taskbar icon.

11. Click Profiles.

![Figure 7-18 Intel® My WiFi Utility - Profiles]
12. Click Profiles, click Intel Wireless PAN and click Edit or New (Note that all preset settings may not be editable - see sidebar).

13. You can change the Profile Name and Network Name to your personal preferences in General (tab).

Profile Settings
Profiles that are preset may not be fully editable. To edit all the profile settings, click New to create a new profile and adjust the settings to your preferences.

Profile and Network Names
The Profile Name is the name as displayed on your computer in the Network Connections control panel (see Figure 7 - 21 on page 7 - 29).

The Network Name (SSID) is the name the devices see when they try to connect to your computer.
14. Click **Security** (tab).
15. Change the **Security Type** to **WEP** and the **Encryption Type** to **64bit**.
16. Enter a password (8 characters long) in the **Password** box.

![Profile Settings](image)

*Figure 7 - 21*
Intel® My WiFi
Profile Settings - Security
17. Click **Sharing** (tab).
18. It is recommended that the **Filter Network Traffic** and **DHCP and DNS Server** are **Disabled**.
19. Click **Advanced** (tab).
20. It is recommended that the **Default Channel** is set to **Channel 1, 6 or 11**.
21. Click **OK** to save the settings.
22. Double-click **Wireless Network Connection** in **Network Connections**.
23. Click **Details** to display the **Network Connection Details**.

*Figure 7 - 24
Wireless Network Connection Details*
24. Access the **Intel® My WiFi Utility** from the **Start** menu (Start &gt; Programs/All Programs &gt; Intel PROSet Wireless &gt; Intel My WiFi Technology), or by clicking the taskbar icon.

25. To add a new device follow the instructions in the devices’ user guide for connecting to a WiFi network.

26. Click **Add New Device** in **Intel® My WiFi Utility** to confirm the security settings detail.
Windows Mobility Center

The **Windows Mobility Center** control panel provides an easy point of access for information on battery status, power plans used and wireless device status etc.

To access the Windows Mobility Center:
1. Click **Start**, and click **Control Panel** (or point to **Settings** and click **Control Panel**).
2. Double-click **Windows Mobility Center** (**Mobile PC**).
3. Click the button to **Turn wireless off/on**, or click the icon to access the network menu.

**Figure 7 - 26**
Windows Mobility Center

Make sure Wireless is ON to ensure proper function key behavior.
PC Camera Module

Before installing the driver, make sure the PC Camera is on. Use the **Fn + F10 key combination** or **Touch Sensor Instant Key** to toggle power to the PC Camera module. When the PC Camera module is powered on, the touch sensor LED will be highlighted and the indicator will briefly be displayed. Make sure you install the drivers in the order indicated in **Table 4 - 1, on page 4 - 3**.

There are a number of different camera modules available with this computer model series. You will have the appropriate application installed for your camera (note that some versions of the camera application do not support the zoom function). **Make sure you access the application via the desktop shortcut.**

**PC Camera Application and Power-Saving States**

If the computer enters **Sleep** or **Hibernate** mode while running the camera application, the program will stop running, and will need to be restarted when the system resumes from the power-saving state.

**Latest PC Camera Driver Information**

Check the **Device Drivers & Utilities + User’s Manual disc** and any accompanying insert pages, for the latest updated information on the PC Camera driver, which may override the information provided here.

**PC Camera Display**

The PC Camera application software needs to be run while the **default notebook LCD** is the selected display device.

After a camera picture is obtained on the default notebook LCD, you may then use the **Fn + F7** to toggle through the display modes (give the screen time to refresh).
PC Camera Driver Installation

1. Insert the *Device Drivers & Utilities + User’s Manual* disc into the CD/DVD drive.
2. Click *Option Drivers* (button).
3. Click 2. *Install WebCam Driver* > *Yes*.
4. Choose the language you prefer and click *Next* > *Next* > *Finish*.
5. Run the camera application program from the desktop shortcut (if the hardware is turned off use the **Fn** + **F10** key combination to turn it on again).
PC Camera Audio Setup

If you wish to capture video & **audio** with your camera, it is necessary to setup the audio recording options in *Windows*.

1. Click **Start**, and click **Control Panel** (or point to **Settings** and click **Control Panel**).
2. Click **Sound** (Hardware and Sound).
3. Click **Recording** (tab).
4. Right-click **Microphone** (Realtek High Definition Audio) and make sure the item is not disabled.
5. Double-click **Microphone** (or select **Properties** from the right-click menu).
6. Click **Levels** (tab), and adjust the **Microphone** and **Microphone Boost** sliders to the level required.
7. Click **OK** and close the control panels.
8. Run the camera application program from the desktop shortcut.
9. Go to the **Devices** menu heading and select **Microphone** (Realtek....) (it should have a tick alongside it).
10. Go to the **Capture** menu heading and select **Capture Audio** (it should have a tick alongside it).
Figure 7 - 27
Audio Setup for PC Camera

Right-click

- BisonCam, NB Pro
- Microphone (Realtek High Definition Audio)

Capture Audio

Start Capture
Stop Capture
Set Time Limit...
Camera Application
The camera application is a video viewer for general purpose video viewing and testing, and for capturing video files to .avi format.

1. Run the camera application from the desktop shortcut (it is recommended that you set the capture file before the capture process - see below).
2. Go to the Capture menu heading (if you wish to capture audio check “PC Camera Audio Setup” on page 7 - 37) and select Start Capture.
3. Click OK/Yes (the file location will be displayed in the pop-up box) to start capturing the video, and press Esc to stop the capture (you can view the file using the Windows Media Player).

Set Capture File
Prior to capturing video files you may select the Set Capture File... option in the File menu, and set the file name and location before capture (this will help avoid accidentally overwriting files). Set the name and location then click Open, then set the "Capture file size:" and click OK. You can then start the capture process as on the previous page.

Note the important information in “Reducing Video File Size” on page 7 - 40 in order to save file space, and help prevent system problems.
Reducing Video File Size
Note that capturing high resolution video files requires a substantial amount of disk space for each file. After recording video, check the video file size (right-click the file and select Properties) and the remaining free space on your hard disk (go to My Computer, right-click the hard disk, and select Properties). If necessary you can remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash drive.

Note that the Windows system requires a minimum of 15GB of free space on the C: drive system partition. In order to prevent system problems it is recommended that you save the captured video file to a location other than the C: drive (see “Set Capture File” on page 7 - 39), limit the file size of the captured video (see “Pre-Allocating File Size/Space” on page 7 - 39) or reduce video resolution (see below).

To Reduce Video Resolution Output Size:
1. Run the camera application program from the desktop shortcut.
2. Go to Options and scroll down to select Video Capture Pin....
3. Click the Output Size drop box and select a lower resolution size in order to reduce the captured file size.
4. Click OK.
Eliminating Screen Flicker
If you find that the video screen in the camera program is flickering, you can try to adjust the setting in the Video Capture Filter options.

1. Run the camera application from the desktop shortcut.
2. Go to Options and scroll down to select Video Capture Filter....
3. Click either 50Hz or 60Hz under Frequency (Anti Flicker).

Latest PC Camera Driver Information
Check the Device Drivers & Utilities + User’s Manual disc, and any accompanying insert pages, for the latest updated information on the PC Camera driver, which may override the information provided here, including the figures pictured here.

Figure 7 - 28
Video Capture Filter
Taking Still Pictures
The camera application allows you to take still pictures.

1. Run the camera application from the desktop shortcut.
2. Go to Options and select Take Picture.
3. The picture (in JPEG format) will be placed in the Snapshot folder on the desktop.

Snapshot Folder
The Snapshot folder's default location is on the desktop. Do not move this folder or an error may appear when you try to take a still picture.

If you accidentally delete or move the folder, you can create a new Snapshot folder on the desktop in order to capture the files.
TV Tuner Module

If your purchase configuration includes the optional Hybrid (Analog & Digital) USB Mini-Card TV Tuner module, you will be supplied with a remote control unit and appropriate antenna and fittings for the module. Software support for the TV Tuner module is provided by Windows Media Center in Windows 7 (not included in Starter or Home Basic versions). A driver is provided on the Device Drivers & Utilities + User’s Manual disc for the remote control supplied with the TV Tuner.

The optional TV Tuner allows you to watch TV, play music CDs, video conference and capture still images and video on your PC.

The Cable (CATV) antenna will only be enabled when a TV Tuner module is installed. Make sure you connect the TV antenna.

TV Antenna
The TV antenna supplied with any TV Tuner module is intended for indoor use only. Please do not use your TV Tuner module outdoors.

TV Tuner Remote
Point the remote at the consumer IR transceiver to change channels etc.

Figure 7 - 29
TV Tuner Ports/ Jacks
1. Consumer Infrared Transceiver
2. CATV Antenna Jack
Modules

Consumer Infrared Driver
1. Insert the *Device Drivers & Utilities + User’s Manual* disc into the CD/DVD drive.
2. Click *Option Drivers* (button).
3. Click 3.Install CIR Driver > Yes.
4. Choose the language you prefer and click Next > Next.
5. Click *Finish* to restart the computer.

Windows Media Center
1. This TV Tuner module is fully supported by *Windows Media Center* in Windows 7 (not included in Starter or Home Basic versions).
2. Run *Windows Media Center* directly from the Start menu (Start > Programs > Windows Media Center).
3. *Windows Help and Support* provides information on the Windows Media Center functions. Click Start and select Help and Support, and then type “Media Center” in the Search Help box and click the magnifying glass icon to bring up the results.

TV Tuner Module Support
Note that the TV Tuner module options in Windows 7 is supported by the Windows Media Center software which comes built-in to all the Windows 7 versions except Starter and Home Basic.

If your purchase includes a TV Tuner option, and you are reconfiguring your system for a different system, you should install any Windows 7 version except Starter and Home Basic.
Digital TV Broadcast Signal

The antenna is the most crucial factor in receiving a clear digital terrestrial TV broadcast signal. The passive antenna provided should provide a clear signal when placed beside a window. If the signal is not clear then you can purchase an active antenna (it should also be placed beside a window) to improve the signal. You should also check with any related government website which provides information on digital terrestrial TV coverage for your area. Note that (unlike standard analog TV) if the digital signal is weak then no picture will appear on the TV at all.

TV Recording and Power Plans

If you intend to use the optional TV Tuner to record live TV, then go to the Power Options control panel and create a power plan (see “Power Plans” on page 3 - 4) to prevent the power saving options from adjusting the computer’s performance level.

Remote Control Unit

The remote control unit allows you to remotely start and send the system into a power saving state, to run Windows Media Center and to navigate the Media Center menus etc. The remote control unit also gives full control over all TV and video functions.
Intel Turbo Memory Module

If you have included an Intel Turbo Memory (Robson) NAND flash memory card module in your purchase option, then install the driver as instructed below. However if you have setup your hard disks in RAID mode you may have already installed this driver (see “Setting Up SATA RAID Mode” on page 7 - 2).

Intel Turbo Memory Technology (also known as Robson flash memory) is an Intel technology that reduces the time it takes for a computer to boot up, to load applications, and to write data to the hard drive.

Intel Turbo & Matrix Storage Setup and Driver Installation

1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive.
2. Click Option Drivers (button).
3. Click 4. Install TM&iMSM Driver > Yes.
4. Click Next > Next > Yes > Next.
5. Click Finish to restart the computer.
6. For Turbo Memory modules that support User Pinning see “Intel Turbo Memory Dashboard (User Pinning Supported Only)” on page 7 - 47.
7. For Turbo Memory modules that do not support User Pinning see “Intel Turbo Memory Console” on page 7 - 50.
Intel Turbo Memory Dashboard (User Pinning Supported Only)
The Intel Turbo Memory Dashboard allows you to pin an application or file to load into the Intel Turbo Memory NAND cache for performance acceleration.

1. Run the Intel® Turbo Memory Dashboard from the Programs/All Programs menu (Intel® Turbo Memory) or from the desktop shortcut.
2. The Pinning Capacity Consumption Meter displays the amount of pinning space used.
3. The Control and Profile Pull-Down Menu allows you to select and manage profiles.
4. The Application Window lists all applications available for performance acceleration. When accelerated the applications/files will appear in the Accelerated Window.
5. The Custom Sets Window allows you to select specific files to be pinned.

Figure 7 - 30
Intel Turbo Memory Dashboard
Pinning an Application

1. The Intel® Turbo Memory Dashboard allows you to select files and applications to accelerate and therefore open faster and display quicker.

2. Applications will be listed in the Applications Window on the right.

3. To accelerate any application drag the icon into the Accelerated pane on the left (the available memory is indicated in the top left).

4. A status bar indicates the pinning progress and will turn green when ready.

Unpinning an Application

Click the application in the Accelerated Window and drag it back to the Applications Window to unpin the application.

You can also unpin the application by right-clicking it in the Applications Window and selecting “Remove from Cache.”

Figure 7 - 31
Accelerated Applications
Custom File Sets
A Custom File Set allows you to group applications and files to accelerate. These sets can be moved easily in and out of the Accelerated Window which is of benefit when space is limited. You need to create the custom file set before dragging the set to the accelerated window.

1. Click Custom File Sets and type a name for the set, and then click Next.
2. Select the file set folder icon and click Advanced.
3. Click the Browse button and select the files and applications to accelerate.
4. Click the Done button when finished.
5. Drag the custom set across to the Accelerated Window from Custom File Sets to accelerate.

Figure 7 - 32
Create Custom File Set
Intel Turbo Memory Module

Intel® Turbo Memory Console
1. Run the Intel® Turbo Memory Console from the Programs/All Programs menu (Intel® Turbo Memory).
2. You can enable/disable Windows ReadyBoost and Windows ReadyDrive from the Intel® Turbo Memory Console.

- Windows ReadyBoost - uses flash memory as a hard-drive caching solution (Not supported if User Pinning is supported).
- Windows ReadyDrive - uses hybrid drives as a hard-drive caching solution.
HDMI-In Module

The optional HDMI-In module allows you to display external sources such as Blu-ray players, DVDs, set top boxes and games consoles etc. on your computer screen. Install the driver as indicated below.

HDMI-In Driver
1. Insert the *Device Drivers & Utilities + User’s Manual* disc into the CD/DVD drive.
2. Click *Option Drivers* (button).
3. Click 5.Install HDMI In Driver > Yes.
4. Click Next.
5. Click Finish (the application will prepare to install).
6. Click Next > Install.
7. Click Finish.
8. The GameMate application will appear on the desktop.
GameMate Media Player (HDMI-In)
The GameMate Media Player allows you to play content from digital sources through the HDMI-In port.

1. Connect your digital source to the HDMI-In port using an HDMI cable.
2. Access the GameMate Media Player from the desktop shortcut or from GameMate folder in Program Files.
3. Press play on any attached digital source player (or use a remote control to navigate the menus of consoles etc.).
4. The picture will appear in the GameMate Media Player.

Figure 7 - 34
GameMate Player
Double-click the GameMate screen to toggle through different screen size options. You can also right-click the screen to access the configuration menu to adjust any of the following settings:

**RENDERED QUALITY**
Select High, Medium or Low quality from this menu item.

```
RENDERED QUALITY
STANDARD
FORMAT
```

**STANDARD**
Select NTSC or PAL standard from this item.

```
STANDARD
FORMAT
```

**FORMAT**
Select the screen format here (only supported resolutions will be shown).

```
STANDARD
FORMAT
```
Modules

ASPECT
The Aspect item allows you to select standard or wide screen aspect ratios.

SNAPSHOT
Click either the BMP or JPG items to take a screen shot of the current GameMate screen (the file will be placed in the Pictures library folder in Windows).

TOPSHOT
If enabled then the GameMate screen will remain on top of other windows.
Fingerprint Reader Module

The fingerprint reader Protector Suite Software provides a high level of security for your computer. A further level of security and control is provided in the BIOS (see “Security Menu” on page 5 - 13).

The fingerprint reader and Protector Suite Software allow you to:

• Access or Lock your computer
• Protect sensitive files
• Display and file your favorite web pages
• Fill in frequently used dialogs
• Run your favorite applications

If you have included the fingerprint reader in your purchase option you will need to install the driver as per the instructions below.

Make sure you have administrator’s rights to your computer, and have a Windows password enabled for full security protection.

Before beginning the enrollment process it is recommended that you go through the fingerprint tutorial (see Figure 7 - 35 on page 7 - 57).
Fingerprint Reader Driver Installation
1. Insert the *Device Drivers & Utilities + User’s Manual* disc into the CD/DVD drive.
2. Click **Option Drivers**.
3. Click **6.Install FingerPrint Driver > Yes**.
4. Click **Next > Next > Next**.
5. Click **Finish > Yes** to restart the computer.
6. Click the tray icon , scan a finger or click **Start > Programs/All Programs > Protector Suite > Control Center and** then begin the enrollment process (see over).
User Enrollment

1. Click **Start > Programs/All Programs > Protector Suite > Control Center**, or double click the taskbar icon (click **Initialize**).
2. On the first run of the program you will be asked to click the **Accept** button to accept the license.
3. If you have not set a *Windows* password you will be prompted to do so (**note:** If you have not set a password **Protector Suite** cannot secure access to your computer).
4. Click **Submit** when you have entered password.
5. You will then be prompted to enroll your fingerprints (you can click **Tutorial** to get help with fingerprint enrollment at any time).

---

**Fingerprint Enrollment**

Note that it is strongly recommended that you enroll more than one finger in case of injury etc.

---

**Figure 7 - 35**

Fingerprint Enrollment

Mustang W650 Notebook
6. Click the button above any of the fingers to begin the enrollment process for that finger.

7. Swipe the finger until the progress bar reaches 100% to enroll that finger.


Figure 7-36
Fingerprint Enrollment Progress

Note that it is strongly recommended that you enroll more than one finger in case of injury etc.
9. Right-click the taskbar icon and select **Start Control Center** (and then swipe a finger) to allow you to **Edit Fingerprints**, register **Applications**, edit **Settings** and access the **Help** menu etc. You can also run the **Control Center** etc. from the **Protector Suite** item in the **Programs/All Programs** menu.

10. Click “**Help**” to get more information on any topic.

11. You can also run the **Tutorial**, or **Product Tour** video to get more information.

12. If you swipe your finger over the reader at any time you can access the **Biomenub** to **lock the computer, register websites**, access the **Personal Safe**, open the **Control Center** and access the **Help** menu.
Fingerprint Control Center Features

Application Launcher
The Application Launcher allows you to register applications to be launched when assigned to a particular finger. Simply copy the application icon onto one of the registered fingers and then click OK to close the application window. Once registered, the application will launch when you swipe the appropriate finger across the sensor.

Password Bank
The Password Bank stores registrations of user names, passwords and other settings for web sites etc.

Personal Safe
The Personal Safe is an encrypted area assigned on your hard drive that allows you to store files and folders to be protected by fingerprint protection.

Help
For more information on these and other features, simply access "Help" in the Fingerprint Control Center and select the item from the menu on the left.
Chapter 8: Troubleshooting

Overview

Should you have any problems with your computer, before consulting your service representative, you may want to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface. If all else fails, talk to your service representative. You should also make a record of what happened and what remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call your service representative.
Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer appears not to be working.

• **Power** - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip, make sure it is actually working. Check the LED Power Indicators (see “LED Indicators” on page 1-7) to see the computer’s power status.

• **Connections** - Check all the cables to make sure that there are no loose connections anywhere.

• **Power Savings** - Make sure that the system is not in Hibernate or Sleep mode by pressing the keys configured in your Power Options (see “Configuring the Power Buttons” on page 3-8), the F_n + F_4 key combination, or power button to wake-up the system.

• **Brightness** - Check the brightness of the screen by pressing the F_n + F_8 and F_9 keys to adjust the brightness (see Table 1-4, on page 1-10).

• **Display Choice** - Press F_n + F_7 to make sure the system is not set to “external only” display.

• **Boot Drive** - Make sure there are no optical media and/or USB storage devices in any connected drive when you start up your machine (this is a common cause of the message “Invalid system disk - Replace the disk, and then press any key” / “Remove disks or other media. Press any key to restart”).
Troubleshooting

Backup and General Maintenance

- Always **backup** your important data, and keep copies of your OS and programs safe, but close to hand. Don’t forget to note the **serial numbers** if you are storing them out of their original cases, e.g. in a CD wallet.

- Run **maintenance programs** on your hard disk and OS as often as you can. You may schedule these programs to run at times when you are not using your computer. You can use those that are provided free with your OS, or buy the more powerful dedicated programs to do so.

- Write down your passwords and keep them safe (away from your computer). This is especially important if you choose to use a **Boot** password for the SCU (see “Security Menu” on page 5 - 13).

- Keep copies of vital **settings files** such as network, dialup settings, mail settings etc. (even if just brief notes).

---

Warranty

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your warranty.
Troubleshooting

Viruses

• Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm your computer and cause you to lose data. Anti-Virus programs are commercially available and the definitions file updates are usually downloadable directly from the internet.

• Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within e-mail attachments so take care when opening any attached file. You can configure most Anti-Virus programs to check all e-mail attachments. Note: You should also beware of files from people you know as the virus may have infected an address book and been automatically forwarded without the person’s knowledge.

• Keep a “Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic information which allows you to startup your computer) handy. You may refer to your OS’s documentation for instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or at least instructions on how to make one).
Upgrading and Adding New Hardware/Software

• Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are doing, otherwise you will risk severely damaging your system.

• Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what you are doing.

• Read the documentation. We can assume, since you are reading this that you are looking at the computer’s manual, but what about any new peripheral devices you have just purchased? Many problems are caused by the installation of new hardware and/or software. Always refer to the documentation of any new hardware and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

• When installing a new device always make sure the device is powered on, and in many cases you will need to restart the computer. Always check that all the cables are correctly connected.

• Make sure you have installed the drivers for any new hardware you have installed (latest driver files are usually available to download from vendor’s websites).

• Thoroughly check any recent changes you made to your system as these changes may affect one or more system components, or software programs. If possible, go back and undo the change you just made and see if the problem still occurs.
Troubleshooting

• Don’t over complicate things. The less you have to deal with then the easier the source of the problem may be found; **Example** - if your computer has many devices plugged into its ports, and a number of programs running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices and restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and removing devices and restarting where necessary) will often find the source of a problem, although this may be time consuming.
# Troubleshooting

## Problems & Possible Solutions

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You turned the <strong>power on</strong> but it doesn’t work.</td>
<td><em>Battery missing / incorrectly installed.</em> Check the battery bay, make sure the battery is present and seated properly (the design of the battery only allows it to go in one way). Make sure there’s nothing interfering with the battery contacts.</td>
</tr>
<tr>
<td>The <strong>Battery LED power indicator</strong> is blinking orange.</td>
<td><strong>Low Battery.</strong> Plug in the AC power source. If the computer doesn’t start up immediately, turn it off then on again.</td>
</tr>
<tr>
<td>You are losing <strong>battery power</strong> too quickly.</td>
<td><strong>The system is using too much power.</strong> If your OS has a <em>Power Options</em> scheme (see “Power Plans” on page 3 - 4) check its settings. You may also be using an ExpressCard device/USB device/external device that is drawing a lot of power.</td>
</tr>
<tr>
<td></td>
<td><strong>You are attempting to run an SLI configuration on battery power.</strong> Due to the high power and system demands created by enabling SLI Configuration, <strong>you should not enable SLI configuration if your computer is powered by battery only.</strong></td>
</tr>
<tr>
<td>Actual <strong>battery operating time</strong> is shorter than expected.</td>
<td><strong>The battery has not been fully discharged before being recharged.</strong> Make sure the battery is fully discharged and recharge it completely before reusing (see “Battery Information” on page 3 - 10).</td>
</tr>
<tr>
<td></td>
<td>Check the settings of any active power plan (see “Power Plans” on page 3 - 4).</td>
</tr>
<tr>
<td></td>
<td><strong>A peripheral device/USB device is consuming a lot of power.</strong> Turn off/remove the unused device to save power.</td>
</tr>
</tbody>
</table>
# Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The computer feels too hot.</td>
<td>Make sure the computer is properly ventilated and the vents/fan intakes are not blocked. If this doesn’t cool it down, put the system into Hibernate mode or turn it off for an hour. Make sure the computer isn’t sitting on a thermal surface (see “Overheating” on page 1-15). Make sure you’re using the correct adapter. Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a notebook which is powered on in a travel bag may cause the vents/fan intakes to be blocked.</td>
</tr>
<tr>
<td>Nothing appears on screen.</td>
<td>The system is in a power saving mode. Toggle the Fn + F4 (see “Configuring the Power Buttons” on page 3-8). The screen controls need to be adjusted. Toggle the screen control Fn + F8/F9 key combinations. If you’re connected to an external monitor, make sure it’s plugged in and turned on. You should also check the monitor’s own brightness and contrast controls. The computer is set for a different display. Toggle the screen display key Fn + F7 combination. If an external monitor is connected, turn it on. The screen saver is activated. Press any key or touch the TouchPad.</td>
</tr>
<tr>
<td>No image appears on the external monitor I have plugged in and powered on.</td>
<td>You haven’t installed the video driver and configured it appropriately from the Control Panel. See “NVIDIA Video Driver Controls” on page B-1 for instructions on installing and configuring the video driver.</td>
</tr>
</tbody>
</table>
### Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You forget the <strong>boot password</strong>.</td>
<td>If you forget the password, you may have to discharge the battery of the CMOS. Contact your service representative for help.</td>
</tr>
<tr>
<td>The <strong>sound</strong> cannot be heard or the volume is very low.</td>
<td>The volume might be set too low. Check the volume control in the Volume Control Panel in the Windows taskbar, use the key combination Fₙ + F₅ and F₆ or move your finger slowly along the volume control slider to adjust the system volume (see “Audio Features” on page 2 - 11/“Touch Sensor Instant Keys” on page 1 - 8) to adjust.</td>
</tr>
<tr>
<td>The <strong>compact disc</strong> cannot be read.</td>
<td>The compact disc is dirty. Clean it with a CD-ROM cleaner kit.</td>
</tr>
<tr>
<td>The <strong>compact disc tray</strong> will not open when there is a disc in the tray.</td>
<td>The compact disc is not correctly placed in the tray. Gently try to remove the disc using the eject hole (see “Loading Discs” on page 2 - 3).</td>
</tr>
<tr>
<td>The <strong>DVD regional codes</strong> can no longer be changed.</td>
<td>The code has been changed the maximum 5 times. See “DVD Regional Codes” on page 2 - 5.</td>
</tr>
</tbody>
</table>

**Password Warning**

If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The TouchPad doesn’t work.</td>
<td><em>The Touchpad has been disabled.</em> Press the Touchpad toggle (<strong>Fn + F1</strong>) key combination (make sure you have installed the Touchpad driver).</td>
</tr>
<tr>
<td>The system freezes or the screen goes dark.</td>
<td><em>The system’s power saving features have timed-out.</em> Use the AC/DC adapter, press a key on the keyboard, or press the sleep (<strong>Fn + F4</strong>) key combination, or press the power button if no LEDs are lit.</td>
</tr>
<tr>
<td>The system never goes into a power saving mode.</td>
<td>Power Options features are not enabled. Go to the <em>Windows</em> Power Options menu and enable the features you prefer (see “Power-Saving States” on page 3 - 6). Make sure you have enabled Hibernate mode from the control panel.</td>
</tr>
<tr>
<td>The Wireless LAN/Bluetooth/PC Camera modules cannot be detected.</td>
<td><em>The modules are off.</em> Check the appropriate LED indicator to see if the modules are on or off (see “Touch Sensor Instant Keys” on page 1 - 8). If the LED indicator is not illuminated, then press the appropriate touch sensor instant key/function key combination in order to enable the modules.</td>
</tr>
<tr>
<td>The Wireless LAN/Bluetooth/PC Camera modules cannot be configured.</td>
<td><em>The driver(s) for the module(s) have not been installed.</em> Make sure you have installed the driver for the appropriate module (see the instructions in Chapter 7 “Modules” for the appropriate module).</td>
</tr>
<tr>
<td>Problem</td>
<td>Possible Cause - Solution</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>When a DVD is played in <a href="#">Windows Media Player/Media Center</a>, the audio track in other languages (commentaries etc.) is not clear if connected to the S/PDIF-Out Jack.</td>
<td>This is an issue with Windows Media Player/Media Center and audio output through the S/PDIF-Out Jack. We recommend that you use the <strong>Power DVD</strong> application to play DVDs.</td>
</tr>
</tbody>
</table>
| Nothing appears on the screen when the PC Camera software is run.     | You have selected an external display as the default display device. The PC Camera application software needs to be run while the **default notebook LCD** is the selected display device.  
After a camera picture is obtained on the default notebook LCD, you may then use the **Fn + F7** to toggle through the display modes (give the screen time to refresh).  
If you have selected an external display as your display device do not run the PC Camera software application until you have switched back to the notebook LCD. |
<p>| A file cannot be copied to/from a connected Bluetooth device.          | The transfer of data between the computer and a Bluetooth enabled device is supported in <strong>one direction only (simultaneous data transfer is not supported)</strong>. If you are copying a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from the Bluetooth enabled device to your computer until the file transfer process from the computer has been completed|
| The Bluetooth module is off after resuming from Sleep.               | The Bluetooth module’s default state will be off after resuming from the Sleep power-saving state. Use the key combination (<strong>Fn + F12</strong>) to power on the Bluetooth module after the computer resumes from Sleep. |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Wireless LAN indicators show that the WLAN module is powered on, however the module does not connect.</td>
<td>The WLAN module is turned off in the Windows Mobility Center. The computer’s wireless function keys will not function properly if Wireless is turned OFF in the Windows Mobility Center control panel. Make sure that Wireless is ON in the Mobility Center to ensure proper function key behavior (see “Wireless Hot Keys” on page 7 - 34).</td>
</tr>
<tr>
<td>No sound can be heard through an HDMI connected display device.</td>
<td>You have not configured the HDMI audio output. See “HDMI Audio Configuration” on page 2 - 8.</td>
</tr>
<tr>
<td>You are experiencing problems with image distortion in a 3D game (or any 3D program) when the computer is powered by the battery.</td>
<td>Where this is the case, install the beta video driver version provided on the Device Drivers &amp; Utilities +User’s Manual disc.</td>
</tr>
</tbody>
</table>
|                                                                         | 1. Insert the Device Drivers & Utilities + User’s Manual disc and click Browse CD/DVD.  
2. The driver is located in the following location on the disc: Drivers\02Video(beta).  
3. Double-click the executable setup file and follow the on-screen instructions to install the driver. |
When the battery is being used to power the system in an environment with an ambient temperature of below 10°C/50°F, the battery reaches a low level very quickly.

This can occur as the battery cell performs poorly in a low temperature environment, especially with a discharge rate of over 2C. Systems powered by the battery will perform normally at environmental temperatures over 10°C/50°F. To use the system at environmental temperatures below 10°C/50°F, it is recommended that the system is powered by the AC/DC adapter.

Battery Notes:

Note that when the battery capacity is measured it may read less than the 5300mAh indicated on the label, and possibly less than 5000mAh. This can be due to either of the following factors:

- The battery capacity listed on the label is defined by cell character specification. There is a -5% capacity tolerance based on a test at 0.2C charge/0.2C discharge. Therefore 5035mAh (-5% of 5300mAh) meets the battery capacity specification listed.
- This system runs with a 0.6C charge/1C~2.5C discharge rate. The higher system charge/discharge rate can result in a lower battery capacity measurement reading.
You have a RAID enabled and the system will not boot to Windows.

1. As the computer starts up press Ctrl + i to enter RAID configuration menu
2. If the RAID volume’s Physical disks are marked in red, then press 4.Recovery Volume Options.
3. If you cannot access 4.Recovery Volume Options (i.e. it is grayed out) then press 5.Acceleration Options.
4. Press Enter and return to the main menu, then press 4.Recovery Volume Options.
5. Follow the on screen instructions to recover the Physical disks.
6. If only one of the physical disks now appears green, then press 6.Exit to save the changes and exit and boot to Windows.
7. When Windows is loaded run the Intel® Matrix Storage Console from the Intel® Matrix Storage Manager in the Programs/All Programs menu.
8. Click View > Advanced Mode.
9. Right-click on the RAID volume and select either Verify Volume Data or Verify and Repair Volume Data.
10. The verification or verification and repair process will run and display progress.
11. A dialog box will display the final status of the verification or verification and repair status.
Bluetooth Connection Problems

If you are experiencing problems connecting to some Bluetooth devices (in particular certain mobile phones and headsets) it maybe necessary to download and install the Windows Mobile Device Center software (for Windows Vista and Windows 7). Go to the Microsoft website and search for the Microsoft Windows Device Center Driver for Windows Vista (64-bit or 32-bit) and Windows 7 (64-bit or 32-bit), and then download the driver.

1. Install the Microsoft Windows Device Center Driver as appropriate for your operating system.
2. Windows Vista will automatically configure the driver for you, however Windows 7 requires further configuration.
3. Make sure the Bluetooth device is powered on.
4. Go the Windows 7 control panel and double-click Device Manager (Hardware and Sound > Devices and Printers).
5. Bluetooth Peripheral Device(s) will be listed under Other Devices (note this will only be listed if you have connected, or tried to connect to, a Bluetooth device previously).

You will need to repeat the procedure listed here for all Bluetooth Peripheral Devices listed under Other Devices i.e. until there are no more Bluetooth Peripheral Devices listed under this menu heading.

Figure 8 - 1 - Device Manager
Troubleshooting

6. Right-click Bluetooth Peripheral Device and click on Update Driver Software.
7. Click Browse my computer for driver software.
8. Click Let Me pick from a list of device drivers on my computer.

Figure 8 - 2 - Browse my computer.../Let me pick from...

9. Select Bluetooth Radios from the list.

Figure 8 - 3 - Select Bluetooth Radios
10. A list of drivers will appear with **Manufacturer** on one side and **Model** in the other.

11. Choose **Microsoft Corporation** (make sure you choose the full name **Microsoft Corporation** and do not choose **Microsoft** - Note that you must have installed the **Microsoft Windows Device Center Driver** for **Microsoft Corporation** to appear in the list).

12. Select **Windows Mobile-based device support** from the **Model** list.

13. Click **Next > Yes** and the driver will install.

14. Click **Close** to complete the installation.
Troubleshooting

15. The Device Manager should now display the Windows Mobile-based device support under Bluetooth Radios.
16. You will need to repeat the process for any other Bluetooth Peripheral Devices listed under Other Devices.

Figure 8 - 5 - Device Manager - Bluetooth Radio
Appendix A: Interface (Ports & Jacks)

Overview

The following chapter will give a quick description of the ports & jacks which allow your computer to communicate with external devices, connect to the internet etc.
## Interface (Ports & Jacks)

### Ports and Jacks

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| Card Reader | The card reader allows you to use the following digital storage cards:  
| | MMC (MultiMedia Card) / RSMMC  
| | SD (Secure Digital) / Mini SD / SDHC / SDXC Compatible  
| | MS (Memory Stick) / MS Pro / MS Duo  
| | Push the card into the slot and it will appear as a removable device. |
| Cable (CATV) Antenna Jack | Use this jack to connect a CATV cable if you have included the *optional* Mini-PCI TV Tuner in your purchase. |
| Consumer Infrared Transceiver | The *consumer infrared* transceiver at the *front* of the computer allows the computer to communicate with the remote control unit supplied with the *optional* Mini-PCI TV Tuner. |
| DC-In Jack | Plug the supplied AC/DC adapter into this jack to power your computer. |
| DVI-Out Port | The DVI-Out (*Digital Visual Interface*) Port is a video connector interface. This allows you to connect an external monitor, TV or Flat Panel Display etc. as a display device (see “Configuring an External Display using the NVIDIA Control Panel” on page B - 7) by means of a DVI cable. If you are using an older type of monitor you will need to use a converter to convert the signal from DVI to VGA. |
## Interface (Ports & Jacks)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>e-SATA Port</td>
<td>This <strong>e-SATA</strong> (external <strong>Serial Advanced Technology Attachment</strong>) port allows you to plug-in external Serial ATA hard drives.</td>
</tr>
<tr>
<td>HDMI-IN Port</td>
<td>The HDMI-In (<strong>High-Definition Multimedia Interface</strong>) port allows you to display external sources such as Blu-ray players, DVDs, set top boxes and games consoles etc. on your computer screen (see <strong>“HDMI-In Module” on page 7 - 51</strong>). The HDMI-In port is enabled with the <strong>optional</strong> (Factory Option) HDMI-In Module only.</td>
</tr>
<tr>
<td>HDMI-Out Port</td>
<td>The HDMI-Out (<strong>High-Definition Multimedia Interface</strong>) port is an audio/video connector interface for transmitting uncompressed digital streams. This allows you to connect an external monitor, TV or Flat Panel Display etc. as a display device (see <strong>“Configuring an External Display using the NVIDIA Control Panel” on page B - 7</strong>) by means of a HDMI cable. <strong>Note</strong> that HDMI carries both audio and video signals (see <strong>“HDMI Audio Configuration” on page 2 - 8</strong>).</td>
</tr>
<tr>
<td>Headphone-Out Jack</td>
<td><strong>Headphones</strong> or <strong>speakers</strong> may be connected through this jack. <strong>Note</strong>: Set your system’s volume to a reduced level before connecting to this jack.</td>
</tr>
<tr>
<td>Line-In Jack</td>
<td>The Line-In jack allows you to play audio sources through the computer’s speakers. <strong>Note</strong> that audio input through Line-in will default to the <strong>mute</strong> setting. To set up your audio sources to play through the Line-in jack go to the <strong>Sound</strong> control panel and make sure the Mute box is not ticked.</td>
</tr>
</tbody>
</table>
## Interface (Ports & Jacks)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microphone-In Jack</td>
<td>Plug an external microphone in to this jack to record on your computer.</td>
</tr>
<tr>
<td><strong>Mini-IEEE 1394b Port</strong></td>
<td>This allows high-speed connection to various peripheral devices, e.g. external disk drives and digital cameras (<em>see note below</em>).</td>
</tr>
<tr>
<td><strong>IEEE 1394b</strong></td>
<td>The Mini-IEEE 1394 ports only support <strong>SELF POWERED</strong> IEEE 1394 devices.</td>
</tr>
</tbody>
</table>
| RJ-45 LAN Jack        | This port supports LAN (Network) functions.  
**Note:** Broadband (e.g. ADSL) modems usually connect to the LAN port. |
| S/PDIF-Out Jack       | This S/PDIF (*Sony/Philips Digital Interface Format*) Out Port allows you to connect your DVD-capable PC to a Dolby AC-3 compatible receiver for "5.1" or 'dts' surround sound. |
| Security Lock Slot    | To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be purchased at any computer store. |
USB 2.0/1.1 Ports

USB 3.0 Port

These USB (Universal Serial Bus) 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into the computer, and unplugged from the computer, without the need to turn the system off (if the power rating of your USB device is 500mA or above, make sure you use the power supply which comes with the device).

The USB 3.0 ports are denoted by their blue color; USB 2.0 ports are colored black. USB 3.0 will transfer data much faster than USB 2.0, and is backwards-compatible with USB 2.0.

Note that the USB 3.0 port requires a driver installation (see “USB 3.0” on page 4 - 7), does not support wake on USB and is not operational under DOS.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB 2.0/1.1 Ports</td>
<td></td>
</tr>
<tr>
<td>USB 3.0 Port</td>
<td></td>
</tr>
<tr>
<td>Interface (Ports &amp; Jacks)</td>
<td></td>
</tr>
<tr>
<td>--------------------------</td>
<td>--</td>
</tr>
</tbody>
</table>
Appendix B: NVIDIA Video Driver Controls

The basic settings for configuring the LCD are outlined in “Video Features” on page 1 - 17.

NVIDIA Video Driver Installation

Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3.

1. Insert the Device Drivers & Utilities + User’s Manual disc and click Install Drivers (button).
2. Click 2. Install Video Driver > Yes.
3. Click Next > Next.
4. Click Finish to restart the computer.

Video Card Options

Note that card types, specifications and drivers are subject to continual updates and changes. Check with your service center for the latest details on video cards supported. Note that not all video card options for this computer model series support SLI configuration (see “Video Adapter Options” on page C - 2, or contact your service center for details).
NVIDIA Video Driver Controls

NVIDIA Control Panel (Win 7)

More advanced video configuration options are provided in the NVIDIA Control Panel tab.

1. Open the Display (see page 1 - 18) control panel.
2. Click Advanced Settings (button).
3. Click GeForce..... (tab).
4. Click Start the NVIDIA Control Panel to make any video adjustments.

OR

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click NVIDIA Control Panel (click "Classic View" from the left of the menu if you are in Control Panel Home).

Figure B - 1
NVIDIA GeForce..... Control Panel
The NVIDIA Control Panel provides additional video configuration controls and tools which allow quick access to features such as display configuration, 3D Settings and Help menus etc.

Navigating the Control Panel

Navigate through the control panels in much the same way as you would a web page. Click on the sub-heading tasks in the left menu (and on the highlighted links) for information. Use the buttons on the top left to go back, forward etc.

Figure B - 2
NVIDIA Control Panels
The Help menus provide index and search features, and direct links to the NVIDIA website etc.

**Figure B - 3**
Help Menu
Display Devices

Note that you can use a DVI cable connected to the DVI-Out port, or an HDMI (High-Definition Multimedia Interface) cable connected to the HDMI-Out port to connect an external display (if you are using an older type of monitor you can use a converter to convert the signal from DVI to VGA). See your display device manual to see which formats are supported.

1. The built-in LCD.
2. An external display connected to the DVI-Out Port.
3. An external display/TV (if the TV supports an HDMI connection) connected to the HDMI-Out Port.

Monitor and TV Tuner

If you are connecting both a monitor/flat panel display to the DVI-Out Port, and a cable/aerial to the optional TV Tuner module, make sure you attach the cable/aerial to the TV Tuner first, then the monitor.

Display Devices

Besides the built-in LCD, you can also use an external monitor/flat panel display as your display device. The display options are:

- The built-in LCD.
- An external display connected to the DVI-Out port.
- An external display connected to the HDMI-Out port.

Note that HDMI supports video and audio signals. DO NOT use the Fn + F7 key combination to toggle through display options when SLI is enabled.
Display Modes

Single Display Mode
Only one of your displays is used.

Duplicate Displays
Duplicate simply shows an exact copy of the Primary display desktop on the other display(s). This mode will drive multiple displays with the same content.

Extend Desktop
Extend Desktop treats both connected displays as separate devices, and they act as a virtual desktop resulting in a large workspace. When enabled, you can drag any icons or windows across to the other display desktop. It is therefore possible to have one program visible in one of the displays, and a different program visible in the other display.
Configuring an External Display using the NVIDIA Control Panel

You can use the NVIDIA control panel to configure any attached displays.

1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Go to NVIDIA Control Panel (see page B - 2).
3. Double-click Display (if the sub-menus are not visible), and then click Set up multiple displays.
4. Any attached display will appear under “1. Select the displays you want to use.”
5. Click the tickbox alongside any display you wish to use.
6. Click Apply > Yes to save any changes made.

Display Not Shown

If the attached display does not appear in the “1. Select the displays you want to use.” window, click “My Display is not shown...” and then click the appropriate button to force detection of the missing display.
NVIDIA Video Driver Controls

Duplicating the Displays
1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Go to NVIDIA Control Panel (see page B - 2).
3. Double-click Display (if the sub-menus are not visible), and then click Set up multiple displays.
4. Any attached display will appear under “1. Select the displays you want to use.”
5. Click the tickbox alongside any display you wish to use.
6. Right-click one of the display icons and click “Duplicate displays....” (select which is to be the primary display) to duplicate the desktop on both displays.
7. Click Apply > Yes to save any changes.

Figure B - 5
Duplicate Displays

Right-click to select Duplicate displays and which is to be used as the primary clone

Select Apply > Yes to save changes
Extending the Display
1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Go to NVIDIA Control Panel (see page B - 2).
3. Double-click Display (if the sub-menus are not visible), and then click Set up multiple displays.
4. Click to select a primary display under “1.Select the displays you want to use.”
5. Right-click one of the display icons and click “Extend Desktop on this display....” to extend the desktop across both displays.
6. Click Apply > Yes to save any changes.
Changing the Primary Display on Extended Displays

1. If you want to switch the primary display if the displays are extended then right-click the secondary display icon.
2. Select Make this the Windows primary display.
3. Click Apply > Yes to save the change.

Figure B - 7
Switch Primary Display

Right-click to select the secondary display and select Make this the Windows primary display.
Attaching Other Displays (Win 7)

Configuring an External Display in Windows 7

1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Go to the Screen resolution control panel.
3. Click the Detect button.
4. The computer will then detect any attached displays.

Function Key Combination

You can use the \text{Fn} + \text{F7} key combination to toggle through the display options:

- Notebook Only
- External Display Only
- Notebook + External Display

Make sure you give the displays enough time to refresh.

DO NOT use the \text{Fn} + \text{F7} key combination to toggle through display options when SLI is enabled.

Figure B - 8

Screen Resolution

Multiple Displays

(Win 7)
5. You can configure the displays from the **Multiple Displays** menu.

- **Duplicate these displays** - Shows an exact copy of the main display desktop on the other display(s)
- **Extend these displays** - Treats both connected displays as separate devices
- **Show desktop only on 1/2** - Only one of your displays is used.
Using the Windows Logo Key + P Key Combination to Switch Displays
You can also use the + P key combination to quickly change display configuration and modes (this is particularly useful when attaching a projector) in Windows 7.

1. Attach your external display to the external monitor port and turn it on.
2. Press the + P key combination.
3. An on-screen menu will pop up.
4. Use the cursor keys (or + P) to select the appropriate configuration from the menu, and press Enter to confirm the selection.

![+ P Display Configuration Selection](Win 7)
SLI Multi GPU Configuration

This computer features an NVIDIA Scalable Link Interface (SLI) that improves graphic quality and performance by combining dual NVIDIA GPUs (two video cards are required) in a single system. To enable/disable SLI Configuration:

1. Go to NVIDIA Control Panel (see page B - 2).
2. Click “+” next to 3D Settings if its sub-items are not shown and then click Set SLI and PhysX configuration.
3. Click “Maximize 3D Performance” under “SLI configuration:”.
4. Click to select “PhysX settings;” Auto-select (recommended) is the default setting.
5. Click Apply and Restart Now to restart the computer (see over).

Video Card Options

Note that card types, specifications and drivers are subject to continual updates and changes. Check with your service center for the latest details on video cards supported. Note that not all video card options for this computer model series support SLI configuration (see “Video Adapter Options” on page C - 2, or contact your service center for details).

Figure B - 11
Set SLI Configuration

Select Restart Now to restart the computer
SLI Multi GPU Configuration & Battery Power

Note that due to the high power and system demands created by enabling SLI Configuration, you should not enable SLI configuration if your computer is powered by battery only. If you attempt to run an SLI configuration when the computer is powered by the battery only, then system problems may occur.

• If the computer is currently powered by battery only do not enable SLI configuration.

• If you have currently enabled SLI configuration, and the computer is powered by the AC/DC adapter, do not switch to battery power only (or go to the NVIDIA Control Panel and disable SLI configuration before switching to battery power only).

SLI Configuration & Multiple Displays

Note that if SLI configuration is enabled only a Single display may be used as the display device.

DO NOT use the Fn + F7 key combination to toggle through display options when SLI is enabled. SLI supports only a Single display, and attempting to configure dual displays may cause an error. Use the NVIDIA control panel to select the display to be used.
Enabling TV Display

To display desktop images on a TV, connect the TV to your computer by using an HDMI cable/DVI cable from the TV to the HDMI-Out port/DVI-Out port (if supported by your TV).

You will need to enable the TV display from the NVIDIA Control Panel as per the instructions on B - 7. The TV will appear as a display option (*1. Select the displays you would like to use.*) when attached to the appropriate port. **Apply** the settings, and then click **Yes** to save the changes.

**Detect Displays**

To get a full range of display options click *“My display is not shown in the list...”*. **HDMI Audio Setup**

See “**HDMI Audio Configuration**” on page 2 - 8 for instructions on configuring audio for HDMI display devices.

Set up your external display (TV or LCD) for HDMI input (see your display device manual).

*Figure B - 12*  
Set Up Multiple Displays  
(with TV connected)
Changing the TV Signal Format

1. When the TV is enabled as a display device click the sub-menus under Video & Television.
2. Click “Change the signal or HD format”.
3. Select the connector or format you want to use (the menu that appears will depend upon your type of connector).
4. Apply the settings, and then click Yes to save the changes.

Figure B - 13
Change the Signal or HD Format
The NVIDIA Control Panel provides additional configuration controls to adjust the TV settings in the Video & Television menu.

Figure B - 14
NVIDIA Control Panels
(Video & Television)
Appendix C: Specifications

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer’s release schedule. Check with your service center for details.
# Specifications

<table>
<thead>
<tr>
<th>Processor</th>
<th>Display</th>
<th>Video Adapter Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intel® Core i7 Processor:</td>
<td>17.3&quot; (43.94cm) FHD (1920 * 1080), 16:9 Wide Screen LED Backlit LCD</td>
<td>nVIDIA® GTX 460M PCIe * 16 Video Card</td>
</tr>
<tr>
<td>975 (3.33GHz)</td>
<td></td>
<td>1.5GB GDDR5 Video RAM on board</td>
</tr>
<tr>
<td>6.4 GT/s on QPI, 8M L3 Cache, 45nm (45 Nanometer), LGA1366 Package, TDP130W</td>
<td></td>
<td>Supports Microsoft DirectX® 11</td>
</tr>
<tr>
<td>950 (3.06GHz)</td>
<td></td>
<td>Supports HDCP</td>
</tr>
<tr>
<td>4.8 GT/s on QPI, 8M L3 Cache, 45nm (45 Nanometer), LGA1366 Package, TDP130W</td>
<td></td>
<td>Supports DVI Dual-Link</td>
</tr>
<tr>
<td>930 (2.8GHz)</td>
<td></td>
<td>Supports OpenGL 3.1</td>
</tr>
<tr>
<td>4.8 GT/s on QPI, 8M L3 Cache, 45nm (45 Nanometer), LGA1366 Package, TDP130W</td>
<td></td>
<td></td>
</tr>
<tr>
<td>920 (2.66GHz)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4.8 GT/s on QPI, 8M L3 Cache, 45nm (45 Nanometer), LGA1366 Package, TDP130W</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Core Logic</td>
<td>Memory</td>
<td>BIOS</td>
</tr>
<tr>
<td>Intel® X58 + ICH10R</td>
<td>Triple Channel DDRIII (DDR3)</td>
<td>One 16Mb Flash ROM</td>
</tr>
<tr>
<td></td>
<td>Three 204 Pin SO-DIMM Sockets</td>
<td>Phoenix™ BIOS</td>
</tr>
<tr>
<td></td>
<td>Supporting DDRIII (DDR3) 1066MHz/1333MHz Memory Modules</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Memory Expandable up to 12GB</td>
<td>Storage</td>
</tr>
<tr>
<td></td>
<td>Compatible with 1GB, 2GB or 4GB Modules</td>
<td>Up to three (Factory Option)</td>
</tr>
<tr>
<td></td>
<td>Video Adapter Options</td>
<td>Changeable 2.5&quot; 9.5 mm (h) SATA (Serial) Hard Disk Drives supporting RAID level 0/1/5</td>
</tr>
<tr>
<td></td>
<td>nVIDIA® GeForce GTX 480M (100W)</td>
<td>One 12.7 mm Super Multi/Blu-Ray Combo/Blu-Ray Writer SATA Optical Device Drive (Factory Option)</td>
</tr>
<tr>
<td></td>
<td>SLI PCIe Video Card</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2GB GDDR3 Video RAM On Board</td>
<td>Turbo Memory</td>
</tr>
<tr>
<td></td>
<td>Supports PCIe * 16</td>
<td>Intel® Turbo Memory 4GB Mini-Card with PCIe Interface</td>
</tr>
<tr>
<td></td>
<td>Supports Microsoft DirectX® 11.0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Supports HDCP</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Supports HDMI 1.4</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Supports SLI</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SUPPORTS DVI Dual Link</td>
<td></td>
</tr>
</tbody>
</table>
### Audio
- High Definition Audio
- S/PDIF Digital Output
- UAA (Universal Audio Architecture)
- Built-In Microphone
- 5 Built-In Speakers and One Subwoofer
- Dolby Home Theater Certified

### Interface
- Two USB 3.0 Ports (No DOS Support)
- Three USB 2.0 Ports
- One HDMI-Out (High-Definition Multimedia Interface) Port-1.4 (with HDCP Support)
- One HDMI-In (High-Definition Multimedia Interface) Port (Factory Option)
- One DVI-Out Port (with CRT out)
- One eSATA Port
- One S/PDIF Out & Surround Out Combo Jack (supporting external 7.1ch audio)
- One Headphone/Speaker-Out Jack
- One Microphone-In Jack
- One Line-In Jack
- One Mini-IEEE1394b Port
- One RJ-45 LAN Jack
- One DC-In Jack
- One CATV-In Jack (for TV Tuner)
- One Consumer Infrared Transceiver for TV Tuner Remote Controller

### Slots
- Three Mini Card Slots:
  - **Slot 1** for PCIe WLAN Module
  - **Slot 2** for PCIe TV Tuner Module OR PCIeTurbo Memory Module
  - **Slot 3** for One HDMI-In Module

### Card Reader
- Embedded 9-in-1 Card Reader
  - MMC / RSMCC
  - SD / Mini SD / SDHC / SDXC Compatible
  - MS / MS Pro / MS Duo

**Note:** Some of these cards require PC adapters that are usually supplied with the cards.
## Specifications

### Communication
- **Built-In 10/100/100 Base-TX Ethernet LAN**
- **Bluetooth 2.1 + EDR (Enhanced Data Rate) Module** *(Factory Option)*
- **Intel® WiFi Link 6200** 1 * 2 (802.11 a/g/n)
  - Half Mini-Card PCIe WLAN Module *(Factory Option)*
- **Intel® WiFi Link 6300** 3 * 3 (802.11 a/g/n)
  - Half Mini-Card PCIe WLAN Module *(Factory Option)*
- **3rd Party 802.11b/g/n Wireless LAN PCIe Interface Half Mini-Card Module** *(Factory Option)*
- **3.0M Pixel PC Video Camera Module** with USB Interface
- **HDMI-In Module** *(Factory Option)*
- **Hybrid TV Tuner Module** *(Factory Option)*

### Operating System
- **Windows® 7**
  - Note that the TV Tuner module (factory) option in is supported by the *Windows Media Center* software. *Windows Media Center* is not included in *Starter* or *Home Basic* versions of *Windows 7*.

### Power Management
- **Supports Wake on LAN**
- **Supports Wake on USB** (for USB 2.0 Only)

### Power
- **Full Range AC/DC Adapter** – AC in 100 - 240V, 50 - 60Hz DC Output 20V, 15A *(300 Watts)*
- **Removable Polymer Smart Lithium-Ion 78.44Wh Main Battery**

### Security
- **Security (Kensington® Type) Lock Slot**
- **BIOS Password**
- **Fingerprint Reader Module**

### Environmental Spec
- **Temperature**
  - Operating: 5°C - 35°C
  - Non-Operating: -20°C - 60°C

### Operating System
- **Relative Humidity**
  - Operating: 20% - 80%
  - Non-Operating: 10% - 90%

### Physical Dimensions & Weight
- **419mm (w) * 286mm (d) * 60.7mm (h)**
- 5.5kg with Single nVIDIA® GeForce GTX 480M Video Card, ODD and 78.44Wh Battery

---

C - 4 Specifications
Mustang W650 Notebook